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Introduction and Installation CHAPTER 1

The patented Microcor® Corrosion Monitoring Technology is developed to 
substantially increase the speed of response over conventional monitoring 
techniques, such as coupons, electrical resistance (ER) probes and linear 
polarization resistance (LPR). It has the ability to make rapid and accurate corrosion 
rate measurements in any environment. 

Software Packages

The Microcor® Tools Software offers a cost effective and simple method to collect, 
save, transfer and display corrosion information from online-operated Microcor 
and E9020 Transmitters, and Microcor Data Loggers. The software is offered in 
two versions to accommodate different corrosion monitoring needs.

1.	 Microcor Tools Standard
2.	 Microcor Tools - Output Interfaces

The Microcor Tools Standard version is a stand-alone software package for 
installation on the user computer to provide data retrieval, storage, and graphical 
presentation of results from Microcor and E9020 Corrosion Transmitters and Data 
Loggers.

Microcor Tools - Output Interfaces is an enhanced version of the standard 
software which provides Modbus and OPC output interfaces for data transfer from 
Microcor and E9020 online transmitters to Distributed Control Systems (DCS), 
Process Control Systems (PCS), or Supervisory Control and Data Acquisition 
(SCADA) systems. This software package is included on RCS Supplied hardware 
such as the Intelligent Interface Unit (IIU).

Software Installation and Activation

The Microcor Tools Software CD comes with the software installation package, 
manuals, and datasheets for PC installation. To install the software, insert the CD 
in the CD-ROM drive and the AutoPlay feature will open the welcome page which 
will provide the necessary links for the installation and other options. If the AutoPlay 
feature is disabled, browse to the MicrocorTools.exe file on the CD and double-
click and follow the onscreen instructions to finish the install. If the default install 
settings are kept (recommended) when installing the Microcor Tools Software, all 
associated files will be installed in the C:\Program Files\MicrocorTools directory.



2 INTRODUCTION AND INSTALLATION

The Microcor Tools - Output Interfaces version requires an activation key from 
the manufacturer. Upon installation, run the software by navigating to Start → All 
Programs → RCS → Microcor Tools. A dialog box with the message “License 
error: No valid license” will be displayed followed by the Software Registration 
dialogue box with the Installation Code (see image below).

Note:  Double-click the Installation Code to ensure the whole code is 
highlighted prior to copying. Sending incorrect or partial Installation 
Code will delay the Serial Key generation and return.

The Installation Code must be emailed to the manufacturer at Activation@
Cosasco.com to generate the Serial Key file. Once the serial key is generated, a 
MicrocorTools.all file will be emailed back as a reply to the SAME email address. 
Copy this file and paste to the Microcor Tools installation directory (default location 
C:\Program Files\MicrocorTools) and open Microcor Tools Software – Output 
Interfaces.

Modifying the Database Location

Microcor Tools Software is not designed as a client/server application; however, it 
may be operated on a network with some minor limitations. The database may be 
read by multiple computers if the database is stored on a central server, but the 
basic configuration file modb.CFG and data may only be written by one computer 
at a time.

If requirements exist for making the database of the Microcor Tools available 
to multiple computers or if the database is to be stored on a central server, the 
location of the database can be changed as follows:

If for example the database is to be stored on a backup server that 
is mapped to the local computer such as in the directory path Z:\
Userdata\Microcor proceed as follows:

1. Create a MicrocorToolsDatabase subfolder in the Z:\Userdata\Microcor. 
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2. Find the dataT.cfg file (the default location is C:\Program Files\MicrocorTools) 
and rename it to data.cfg

3. Right-click the data.cfg file and select Open with to edit the content with 
Notepad or WordPad (shown below): 

Following Microsoft dialog boxes may appear:

Choose Open With… and the following dialog box will open:
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Choose Select the program from a list and click OK. Choose Notepad or 
WordPad from the next screen to proceed to edit the data.cfg file.

4. When the Notepad editor opens, change the path C:\aa with the 
following path Z:\Userdata\Microcor\MicrocorToolsDatabase 
(shown below) and Save and Exit.

Note:  If the Microcor Tools Software program has already been used 
and data has been collected, then this collected data can be 
transferred to the new shared database location. Copy the 
data file directory (not the newly renamed data.cfg file) from C:\
Program Files\MicrocorTools to the new directory.

It is also possible to share the database when a single computer is shared amongst 
multiple users. Simply choose a shared location such as Shared Documents of 
the All Users profile for the database and follow the above procedure.
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Optional DataRemoting Software Add-On for Remote Data Collection (WAN/LAN)

Microcor Tools Software offers Microcor® Tools DataRemoting System as an 
optional add-in software bundle that is designed to expand on the existing Microcor 
Tools – Output Interfaces capabilities and enable remote data collection over LAN/
WAN configurations. Microcor Tools DataRemoting is ideal and cost effective 
for remote data backup, adding alternate or multiple data monitoring points, or 
centralization of multiple sites. The Microcor Remote Server will preserve original 
features, settings, and data collection capabilities for onsite management while 
allowing data transfer to a Microcor Remote Client (Central Server) over LAN/WAN 
via a Modbus IP.
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Configuration and Setup CHAPTER 2

To launch the Microcor Tools program, click Start → All Programs → RCS → 
Microcor Tools. 

Note:	 This reference manual will use Microcor Tools – Output 
Interfaces screen captures unless otherwise stated, some 
of the command buttons and features may not be available 
on the Microcor Tools Standard version of the software.

 
Onscreen help is accessible by clicking on the Help button and the Save button 
will store and retain all configuration changes.

Create, Select and Remove Sites

A Site is a collection of up to 100 corrosion-monitoring locations. The corrosion 
information for these locations can be provided from the following data sources:

•	 Online data collection via the RS485 network from Microcor Transmitters
•	 Online data collection via RS485 network from Corrater E9020 Transmitters
•	 Offline data input from Microcor Data Loggers or data-transfer units
•	 Offline data imported from archives or files, or the previous versions of Microcor software.
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Create a Site

Select the New Site option button and type a name in the text box (Existing Sites 
option button is selected by default). Click the Create Site command button.

Select an Existing Site

Select the Existing Sites option button, open the list box and click on the desired 
site name.

Remove a Site

Select the Existing Sites option button, open the list box and click on the desired 
site name. Click the Remove command button to remove the site.

Use the Save command button at the bottom of the screen to store all settings 
for the selected site.

Configuring Site and Instrument Locations

1.	 Create a new site or use the Site list box on the Site/Communications tab 
to select a site.

2.	 Click the Config/DL Transfer tab to select the configuration screen.
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3.	 Locate the Address area. Use the up/down control buttons to select the unit 
address or type the number in the text box (0 – 99).

If the data source for this location is an online transmitter, the Address must be 
equal to the transmitter address.  Internally, each transmitter has a DIP switch 
with a selectable address (0 to 99 for Model MT 9485A and E9020 and 0 to 31 for 
Model MT 9485.  The preset address is marked on the outside of the transmitter as 
the IN# or Instrument Number. See the transmitter manual for more details. If the 
data source is a data logger or data-transfer unit, RCS recommends that the IN # 
of the transmitter connecting to the data logger is used. 

4.	 Type in the Com Port # being used on the computer to communicate with the 
instrument. This may be an actual hardware port on the computer or a virtual 
Com Port for operation with a TCP/IP converter via the network. This setting 
is only for Online connections and is disabled for Data Logger connections.

5.	 Complete the Description field with the provided free-format text description 
area to meaningfully identify the location (optional). The first 50 characters of 
the Description field will be displayed on the History Viewer graph display 
along with the Site, Address, and Tag information for easy identification. 

6.	 Proceed to the Connection, Instrument and Rate/Alarms Settings area. 

Click the checkbox to select either Online or Data Logger data transfer method. 
Data Logger checkbox is enabled only when the Start button on the Data Logger 
Communication section of the Site/Communications tab is pressed and when 
the instrument is set as Microcor. Data Logger Communication must be started 
to be able to check or uncheck the above Data Logger box. Supported transmitters 
are Microcor (MT 9485A and Microcor MT 9485) and Corrater E9020. E9020 
transmitters are used with Online connections only. 

Note:	 It is important to ensure that the “Hibernate,” “System 
Standby” and “Turn off hard disks” on the Windows Power 
Options is turned to “Never” so data collection will not be 
interrupted on Online systems.
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The Rate/Alarms Settings command button opens the following screen:

Users can choose to enable the alarm by selecting the CR/ER Alarm Enabled 
button. However, it is important to note that this feature is only relevant when used 
with Online systems. Alarm Level can be changed by typing in the desired value. 
The measurement units are specified to the right of the alarm level value and this 
can be changed in the Graphical Display (History Viewer) screen (click on the 
Show Data command button; see the Retrieving and Plotting Data (History 
Viewer) section for more details). Once the alarm is activated, the Parameter 
3 column on the Data Display screen will turn red if the corrosion rate exceeds 
the set alarm rate. A blinking red/gray indicator with text “ALARM” will replace 
the green “ALARM OK” indicator on the status bar located on the bottom of the 
Microcor Tools application screen (see the section on the Online Data Collection 
below for more details). 

The standard method for corrosion rate calculations is Linear Regression, which 
can be changed by checking the 24h Filter.  Checking the 24h Filter adds a 
24 hour filter specifically to reduce the effects of any diurnal (24) thermal noise. 
Linear Regression values are adjustable and can be set on the Graphical Display 
(History Viewer) screen.

The Negative Rates Suppression enables the user to visually suppress the 
negative corrosion/erosion values on the graph that are due to the noise in the 
raw signal. When this option is enabled, negative values will show as zero (0) thus 
depicting the minimal corrosion/erosion as zero.

7.	 Proceed to and complete the Probe section once the above selections are 
made.

Type is an optional informational field which will be useful later when reviewing the 
corrosion/erosion data. Element passes information when configuring E9020 so 
it is highly recommended that this field not be empty. These pull-down menus will 
provide most of the typical RCS equipment configurations. It is possible however, 
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to type content in on these fields if the user requires customized, non-default 
selections. When working with Microcor Instruments, probes designated with type 
“M” are used for corrosion monitoring and type “S” are used for erosion monitoring.

Span [mils] is the useable life of the probe element when working with Microcor 
Instruments. This is always defined in units of mils and is one half of the probe 
element thickness (i.e. F10 or T10 probes have a 5 mil span). This required field is 
used to define the physical scale of the metal loss graph. 

For E9020 Instruments, Alloy Multiplier is used instead of the Span. 

The appropriate Span or Multiplier is automatically set when the Probe Element 
is chosen from the drop down menu; however, users may change the Span or 
Multiplier by typing in a different value if necessary. If the required Probe Element 
is not in the list, choose BLIND as the Element, which will set the Span or Multiplier 
to 1; this can be changed as needed (set the Alloy Multiplier to the appropriate 
multiplier value for the metal or alloy of the electrodes as shown in the chart of 
Appendix 1).

Note:	 Make sure to choose the proper Element and Multiplier 
values as these will be passed automatically to the E9020 
Setup screen. 

Note:	 The BLIND setting may also be used with the Microcor 
Tools – Output Interfaces version when used on blind 
Intelligent Interface Units. This allows scaling changes for 
different probe spans to be accommodated internally on 
the IIU such as in DCS or SCADA systems.

8.	 Proceed and complete the Transmitter section (this information is necessary 
for both Online and Data Logger connection types).
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Sampling Interval is used to set the data-record frequency.

For Online metal loss (Microcor) transmitters (MT 9485A and MT 9485) the 
minimum recommended setting is 2 minutes. A typical Sampling Interval would 
be 5 minutes, which will yield 12 readings per hour. This option is unavailable for 
corrosion rate transmitters (E9020); the cycle time is configured by the E9020 
Setup command button. 

For Microcor Transmitters driven by Data Loggers, where battery consumption is 
a consideration, a Sampling Interval of 3 hours (180 minutes) is usually selected.  
This gives a battery life of up to one year, and still provides eight readings per day. 
The minimum recommended Sampling Interval for Data Loggers is 30 minutes 
with the maximum setting at 1440 minutes (one day).

Tag is an optional free-format text field used to identify the probe, which provides 
labeling on the graphical display (History Viewer) screen.

Check the Probe Temperature check-box if the transmitter has the probe 
temperature measurement capability and if the function is enabled by the 
internal transmitter DIP switch (see transmitter manual for details).  Temperature 
measurement is available only on certain probe models. Select (type in) values 
for Zero and Gain to calibrate the measurement. If calibration parameters are 
unknown for probes and transmitters, select 0 for Zero and 31 for Gain. If the 
probe-temperature measurement function in the transmitter is not enabled or the 
transmitter does not support probe-temperature measurements uncheck the 
Probe Temperature check-box.

Use the E9020 Setup command button to open and configure the corrosion rate 
transmitters (shown below):

The two sections represent the settings stored in the computer (Database) and 
in the instrument (E9020). The arrow command buttons provide settings transfer 
capability from one to the other:

- from the Database to E9020
- from E9020 to the Database



MICROCOR® TOOLS  SOFTWARE VERSION 4.4.5 13

To store the new configuration from the database to the E9020, choose the bottom 
arrow pointing to the right. To read the current configuration of the E9020 and store 
to the Database, choose the top button with the arrow pointing left.

Cycle Time is used to set the desired measurement cycle time. For water with 
conductivities greater than 100 µS, any cycle time of 5 minutes or more should be 
satisfactory. For lower conductivity water, or when filming type inhibitors are in use, 
it is recommended that the 20 minute cycle time be selected first. After consistent 
readings are obtained, a shorter time cycle can be selected as long as the readings 
do not increase substantially (>5%) over the readings taken with a 20 minute cycle.

The Alloy Multiplier and the Element values will be automatically updated from 
the Config/DL Tranfer screen values.

The default selection on the E9020 setup for the Electrode type is Standard. 
Keep the selection Standard if using a probe with protruding 5.0 square centimeter 
electrodes or select Flush if using a probe with flush 0.5 square centimeter 
electrodes.

The Transmitter Test command button is enabled for Online connections. It sends 
requests to the transmitter and displays returned data in the Answer text field if the 
communication is successful.

9.	 If using data loggers, first make a complete list of the IDs (Addresses), Tags 
and descriptions to be used. This will help organize and manage sites.

Note:	 The ID (address) of the data logger is independent of the 
address of the transmitter to which it is connected.  The data 
logger communicates with a transmitter irrespective of the 
transmitter address.  The ID (address) of the data logger is 
allocated by this software or from the Mate or Mate II during 
configuration of the data logger in order to segregate the 
different sets of data.

10.	The Microcor Tools software allows the direct connection from a PC to a data 
logger, (this may be used ONLY in an electrically safe area).  Alternatively, 
the data loggers can be programmed and data retrieved with the intrinsically 
safe Mate or Mate II instrument programmed in Micromate mode or with a 
Checkmate DL programmed for Microcor Systems, then the data can be 
transferred to the PC in the safe area.

11.	When using a direct PC-to-data logger connection, the data logger screen below 
is used for configuration and data retrieval after the Com Port # is enabled in 
the Data Logger Communication section in the Site/Communications tab.
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Read Setup command button – reads and displays the data logger setup and 
status information. Use this command to check the settings of the data logger 
before the data transfer.

Store Setup command button – reads the Tag and Sampling Interval settings 
from the Transmitter section and stores this information to the Data Logger. It 
will also set the data logger ID equal to the selected Address, and the data logger 
real-time clock to match the computer date and time.  

Note:	 Make sure the computer is set to the correct regional 
settings and time zone in the Control Panel (Classic View).

Read Data command button – reads the collected corrosion information from the 
data logger and stores it in the computer.

Clear Data command button – use this command to delete the data logger memory.

When using the Micromate to configure the Microcor Data Logger, see the section 
on Configuration of Data Loggers with Micromate. Refer to the Checkmate DL 
User Manual for instructions on configuring Microcor Data Loggers with Checkmate 
DL. 

Commands

This section is used to handle history information; display, delete, move, and load 
data from archives.

Show Data command button – opens the Microcor Tools – History Viewer (see 
the Retrieving and Plotting Data (History Viewer) section for more details).

Delete Data command button – deletes the corrosion data stored for this location.

Move to Archives command button – moves the data file to an “archives” folder. 
Archive files have automatically assigned names. For example, the archive file 
of location Address 15, created on 13 May, 2003 is: ch15_13May03.dat.  See 
separate section on Archiving.

Load from Archives command button – use this command to load data from 
archives or import data from previous versions of Microcor. Then use the Show 
Data command to display the information graphically. This command can also be 
used to import data from other Microcor files (on the hard drive or floppy disk).

Apply command button – only applies the changes to the current session. When 
the program is restarted, the applied settings will be lost. 
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Note:	 To permanently save the configuration on the hard disk, 
select the Site/Communications tab and choose Yes when 
the following dialogue box appears or the click the Save 
command button.

Note:	 Data files (*.DAT) that are imported do not include probe 
reading interval or probe span details. This must be separately 
added on the Config/DL Transfer screen. This information is 
stored in the file (*.SET) of the original data folder.

12.	At this point the settings for the current instrument are complete.  For the next 
instrument select new Address and repeat steps 1 to 11.

Note:	 The entries may be made for all of the instruments before 
saving the settings.  However, saving the settings after the 
entries for each location avoids the chance of losing the data 
accidentally. To save the configuration on the hard disk, select 
the Site/Communications tab and click the Save command.
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Online Data Collection CHAPTER 3

Starting and Stopping Data Collection

For online data collection, use the Online Communication section in the Site/
Communications tab. 

Note:	 It is important to ensure that the “Hibernate,” “System 
Standby” and “Turn off hard disks” on the Windows 
Power Options is turned to “Never” so data collection will 
not be interrupted on Online systems. Windows Power 
Options can be found on the Control Panel (Classic View) 
of the Windows Operating System. 

1.	 If all transmitters communicating with the software  are  multi-drop connected 
to a single com port, it is possible to apply that com port value to all addresses 
with the Default Port and the Set Default Port command button. First, select 
the Default Port number (1 – 256) with the up/down keys. Then click the Set 
Default Port command button to apply that to all the transmitters. This control 
is ideal if all or majority of the transmitters are setup on one com port. It is 
possible to then navigate to the other addresses (that are not on the same com 
port) on the Config/DL Transfer tab and overwrite the com port.

2.	 Click the Start command button to turn the communication on.  At this point 
the program commences polling the Online connected transmitters. Real-time 
information from the transmitters is displayed in the Data Display tab. Use this 
view for troubleshooting and checking the operation of the transmitters and the 
RS485 bus.

Note:	 Ensure that the Microsoft Windows “Turn off hard disks”, 
“System standby” and “System hibernates” are disabled 
when setting up Online Communication. 
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3.	 Click the Start command button in the Data Collection section to start 
collecting data from the transmitters to their respective data files. One solid 
green indicator with text “ALARM OK” and one flashing green/yellow indicator 
with text “DATA” will appear on the status bar to indicate that the program is 
collecting data (see images below). 

If the solid green indicator starts to blink red with text “ALARM” and gray, then it 
is indicating that the corrosion rate level of at least one unit has surpassed the 
set alarm level on the Rate/Alarm Settings area (only when alarm conditions are 
enabled on the Rate/Alarms Settings screen). 

The Parameter 2 (for E9020) and Parameter 3 (for Microcor) of the unit(s) in 
alarm status (at the Data Display screen) will turn red and the Event Log will 
display detailed information of the unit(s). Click on the blinking “ALARM” indicator 
on the status bar to acknowledge the alarm. This will stop the blinking and reset 
the status bar indicator to solid red and the Parameter of the unit(s) in alarm to 
yellow. This means there is an ongoing alarm, and it is acknowledged. When the 
alarm is turned off or when the corrosion rate resets to below the alarm rate, the 
indicator light will turn to solid green with the text “ALARM OK”. If a unit enters an 
alarm status and resets prior to user acknowledgement, red indicator will change 
color to blinking green and gray and will reflect this on the Event Log; hence it is 
highly recommended that the Event Log is inspected regularly.

Normal Operation

Status Bar:
First Icon – 	 Group Alarm - Solid green, indicates active data collection and 
corrosion rate level below alarm value.
Second Icon - 	Transmitter Status - Flashing green/yellow, indicates reading of 
probe transmitters is active (normal).
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Data Display Screen:
Corrosion rate level below alarm value so no alarm activity shown.

 
Event Log Screen:
Communication is okay.

Active Alarm

Status Bar:
First Icon – Group Alarm - Flashing red/gray, indicates corrosion rate level of at 
least one unit has surpassed the set alarm value.

Second Icon - Transmitter Status - Flashing green/yellow, indicates reading of 
probe transmitters is active (normal).

Data Display Screen:
Parameter 3 will turn red to indicate active alarm status.

Event Log:
Alarm status is recorded on the Description area.

Alarm Acknowledged

Status Bar:
First Icon – 	 Group Alarm - Solid red, indicates user acknowledged the alarm 
but the alarm condition still persists. This will turn to solid green when the alarm is 
turned off or when the conditions return back to normalcy.
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Second Icon - 	Transmitter Status - Flashing green/yellow, indicates reading of 
probe transmitters is active (normal).

Data Display Screen:
Parameter 3 will turn yellow to indicate user acknowledgment of tripped alarm.

Event Log:
Description changed to show “Alarm Recognized” status.

Alarm Reset Prior to User Acknowledgement

Status Bar:
First Icon – 	 Group Alarm - Flashing green/gray, indicates alarm was tripped 
but the condition returned to normalcy.
Second Icon - 	Transmitter Status - Flashing green/yellow, indicates reading of 
probe transmitters is active (normal).

Data Display Screen:
Parameter 3 will not show any change of status.

Event Log:
Description will record the date, time and ID of the unit(s) which was in alarm 
status.
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4.	 When using Microcor Tools for online monitoring, it should be setup in the 
Microsoft Windows Startup folder and the Autostart checkbox should 
be checked.  This ensures that the program will restart automatically and 
commence the online communication and data collection when the computer 
is restarted after maintenance or power failure.

Note:	 Users may require Power User or Administrative privileges 
to perform the below operations and should always 
consult the organization’s IT Department for assistance 
and permissions.

To add Microcor Tools to the Windows Startup folder, copy the Microcor Tools 
icon form the desktop and paste it in the C:\Documents and Settings\All Users\
Start Menu\Programs\Startup directory. 

5.	 The Auto Archiving feature is designed for computers or embedded 
computers as in the RCS IIU with limited storage resources. If the Auto 
Archiving is selected, when a site collects 2MB of data (approximately 
48,620 readings or 67 days of continuous data collection (temperature 
data collection enabled) at a sampling interval of 2 minutes), the data file is 
automatically transferred into the archives folders replacing the previously 
stored data file, and the current data file will be cleared for collection of new 
data.

Note:	 When Auto Archiving is enabled, Microcor Tools initiates 
automatic archiving when the file reaches its limit, previous 
automatically stored archives will be deleted. This process 
will not delete any manually archived files.

6.	 Microcor Tools - Output Interface software (installed on all RCS Intelligent 
Interface Units) allows users to setup data communication with other 
computers. Click the Interfaces Configuration button to enter the setup 
screen shown below. Select the desired method of transfer and configure the 
fields if necessary. Click the Enabled radio button for the selected data transfer 
method and click the Save Configuration button prior to pressing Return.

Typically only one interface, either Modbus or OPC, is used at a time.  However, 
it is possibly to use both output interfaces at the same time if required.  Microcor 
Tools acts as a Modbus slave and its address is set in the Device window.  The 
Com Port should be set to correspond to the hardwired connection to the Modbus 
Master.  If Microcor Tools is supplied on an RCS computer or embedded PC, the 
Modbus communications may be via RS 232, or two or four wire RS 485 according 
to the unit ordered.  Most commonly, Remote Terminal Unit (RTU) binary protocol 
is used for economy of transmission data length.  This and the baud rate, parity, 
data bits, and stop bits should be set to match the Modbus master with which it 
is communicating.  The Modbus addresses and data format is shown in Appendix 
2. Generally, floating point is not part of the Modbus Standard but there exist two 
different versions for data transmission. The Swapped floating point is provided 
to adapt the Microcor Tools data output to the customer format. 
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The OPC Interface is a Microsoft standardized database interchange protocol 
which uses the computers network interface card (NIC) to communicate via the 
network.  Also included with the Microcor Tools Software - Output Interface 
option is a simple OPC Client Test Utility which enables testing of the OPC output. 
See Appendix 3 for further details.  

7.	 To view the collected data, switch to Config/DL Transfer screen and change 
the Address to the desired ID. Click on the Show Data command button to 
open the Microcor Tools – History Viewer (see the Retrieving and Plotting 
Data (History Viewer) section for more details). An alternate method is to 
switch to Data Display screen and double click on the desired Tag to open the 
Microcor Tools – History Viewer. 

Testing Channels

Individual transmitter channels may be checked with the Transmitter section on 
the Config/DL Transfer screen.

1.	 Click the Transmitter Test command button.

2.	 Successful transmission will return raw data and display it in the Answer text 
field. 
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Microcor Troubleshooting

If abnormal readings or excursions occur that cannot be explained, the system 
electronics should be verified by connecting the meter prover RCS PN 20407-001 
(included in Microcor Installtion Kit RCS PN 702109) in place of the probe and/or 
probe adapter and checking that the reading is approximately 50% of the probe 
span.

If the meter prover shows the electronics are operating correctly, then inspect the 
probe-to-transmitter connections, the probe adapter and/or the probe for damage, 
high resistance, corrosion or poor connections.

After initial application of power, the transmitter takes approximately one minute 
to start up. During that time, it will send the error code -999,999 or -999,996 when 
the data is requested.

On ICMS3 systems, these codes will show up as error messages:
-999,999 – “Startup Mode”
-999,996 – “Auto Ranging”

If there is a probe or probe connection failure, error code -999,998 or -999,997 
will be generated.
On ICMS3 systems, this will display as follows:
Code: -999,998 Display: Probe Fault (4)
Code: -999,997 Display: Probe Fault (1)

If communication with the selected transmitter fails, a “No Answer” error message 
will be generated in the status bar located at the bottom of the screen.

If an error message occurs, check the following:

•	 All connections are correct and the system is connected properly.

•	 The correct Com Port # is being used and that the Online Communica-
tion has been started on the Site/Communications screen.

•	 The transmitter Address (or Instrument #) is correct.

•	 There is power to the transmitter.

3.	 Repeat the test by pressing Transmitter Test again.

4.	 Repeat as required for other RS485 locations.
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Data Collection from
Data Logger CHAPTER 4

1.	 For data loggers installed in non-hazardous areas, the configuration and data 
retrieval may be done directly with a portable PC.

2.	 For data loggers installed in hazardous areas, the configuration and data retrieval 
is made with the intrinsically safe Corrdata Mate or Mate II Data Transfer units 
running Micromate software or with the Checkmate DL handheld instrument 
programmed for Microcor Systems.  Collected data is then transferred to the 
PC in the safe area.  In this case, the Micromate and Checkmate DL emulate 
each data logger so that the software program retrieves collected data from 
them as it would from a data logger.

Note:	 To configure a Microcor Data Logger from a Micromate or 
a Checkmate DL, follow the recommended suggestions 
below:

1. If a collection of data loggers exist on the PC, prepare a list that 
contains each data logger and its respective Address and Tag in 
advance to making the trip to the installed area. 

2. Once in the field, connect the Micromate/Checkmate DL to 
the Microcor Data Logger and perform the programming with the 
information corresponding to the pre-made list from above. Refer to 
the Micromate and Checkmate DL User Manuals for more details.

Configuration of Data Loggers with PC

1.	 Connect the PC or portable PC to the data logger with the cable P/N 748204 for data 
logger Model ML 9500A or cable P/N 748243 for data logger Model ML 9500B.

2.	 Select the Com Port # being used on the computer and click the Start button.
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3.	 Switch to the Config/DL Transfer screen and select the Address and click 
the Data Logger checkbox in the Connection section and configure the 
transmitter as described previously.

4.	 Click the Store Setup command button in the Data Logger section. This will 
populate the text fields in the Data Logger area accordingly. Verify all the text 
fields including Time and Date, and Battery for accuracy. Read Setup will 
interrogate the data logger and display stored values and will enable verification 
of these stored values. 

If the data loggers are in a hazardous area, they will need to be configured with the 
Corrdata Mate or Mate II programmed with the Micromate software or Checkmate 
DL programmed for Microcor Systems.  Make a note of the configuration information 
as this will have to be entered again into the Micromate or the Checkmate DL. 

Data Collection from Data Loggers with PC

1.	 Connect the portable PC to the data logger communications port with cable 
P/N 748204 for data logger Model ML 9500A or cable P/N 748243 for data 
logger model ML 9500B. 

2.	 Switch ON the portable PC and start the Microcor Tools Software program.

3.	 Select the Site from the Existing Sites or create a New Site. Select the Com 
Port # from the Data Logger Communication section and click Start command 
button.

4.	 Switch to the Config/DL Transfer screen. Select the desired Address and 
Comm Port.

5.	 Click the Read Setup command button in the Data Logger section.  This will 
interrogate the data logger and display the resulting information in the text 
fields.
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The time and date shown in Time and Date box should correspond to the current 
time.  If there is an error or drift in the time, this can be corrected with the Store 
Setup command.

The Battery text field should read OK.  If it reads Replace, then the battery needs 
to be replaced on the data logger and the data MUST be cleared after collection 
for data collection to recommence.

Important Note:	 When the data logger battery gets too low to drive 
the transmitter, it shuts off the transmitter, and sets 
the Battery Replace flag.  At this point there may 
still be enough power in the battery to drive the data 
logger for some time and even allow downloading of 
data.  The battery must be replaced in order for the 
transmitter to run again.  If the data is not cleared 
after the battery is replaced, the flag will not be reset 
and no data will be collected from the transmitter.  

The Sampling Interval text field should correspond to Sampling Interval in the 
Transmitter section.

6.	 Click the Read Data button. If data from this location has already been 
collected, the following message will appear:

•	 Press Yes to add the new data onto an existing file.  This is the normal 
method if the data in the data logger is deleted after it is collected each 
time in order to speed data transfer. It also prevents reaching the maximum 
storage capacity in the data logger at which time the data collection stops.

•	 Press No if all of the data in the Micromate/Checkmate DL is to replace 
an existing file. This should be used if the data in the data logger is NOT 
cleared each time it is read. In this case the existing file is automatically 
archived.

•	 Press Cancel to exit the Read Data function.

Note:	 The Microcor Data Logger will store up to 8000 readings before 
collection memory is fully allocated; at this point, collection of 
data will halt until data is cleared from memory. The normal 
recommended practice is to collect data and then clear the data 
in the data logger.  The new data is then appended to the stored 
data file on the PC and the data transfer time is minimized.
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After a selection has been made, a counter in the status bar indicates the number 
of samples to be transferred. Status bar will read End of Transfer when the data 
is successfully transferred from the data logger to the Microcor Tools Software 
program.

7.	 Verify that the data is transferred correctly - click the Show Data command 
button to display the data with the Microcor Tools – History Viewer.

8.	 It is recommended to clear the data in the data logger by clicking the Clear 
Data command button at this point to reduce the data transfer times on later 
downloads.

9.	 Repeat the steps 1 to 8 for each of the data loggers from which data is collected.  
Make sure that the correct Address is selected for each data logger before 
loading the data.

Note:	 The data logger checks the battery status during the 
maximum-load time intervals. If the battery voltage is low, 
a battery Replace status is set in non-volatile memory. In 
this state the data logger does not power the transmitter 
and does not collect data. Other functions and commands 
such as Read Setup, Store Setup, Load Data, and 
Clear Data are not affected. The data logger will remain 
in this state until Clear Data command is executed after 
replacing the battery.

Configuration of Data Loggers with Micromate

First, connect the Microcor transmitter and data logger as described in their 
operating manuals.  Ensure that the battery in the data logger is connected.

Note:	 The data logger enclosure is rated explosion proof, with 
an intrinsically safe RS 232 communications port. When 
operating the data logger in a hazardous area, a hot work 
permit will be required to install or replace the battery 
which is housed in the explosion proof enclosure.

1.	 Verify that the Corrdata Mate or Mate II is programmed with the Micromate 
software for use with Microcor Data Loggers. The Corrdata Mate programmed 
as a Micromate will appear as follows when switched on:

   Micromate ver x.xx
       Free Readings 24500

Mate Battery: OK
                                     More

If the Corrdata Mate is programmed for operation with Corrosometer and Corrater 
probes and data loggers, the screen will appear as follows when switched on:
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ROHRBACK COSASCO SYSTEMS

Read   Disp   Dump   Mate

2.	 Setting up the Corrdata Mate or Mate II with Micromate software is described 
in steps 3 to 11.  If Micromate is already installed on the Corrdata Mate or Mate 
II, skip to step 12.  The Corrdata Mate or Mate II is software programmable. For 
reasons of memory limitations, the Corrdata Mate or Mate II is programmed 
either for use with the Corrosometer and Corrater range of probes and data 
loggers, or with the Micromate software for use with the Microcor range of data 
loggers. The Mate Programming Utility allows the program in the Corrdata 
Mate to be changed back and forth if required.  This process is also used to set 
the Time Zone in the Micromate which is required for the correct date and time 
function of the Microcor Software application.

3.	 Make sure that the Mate Programming Utility has been installed on the PC.

4.	 To start the Mate Programming Utility, click Start → All Programs → RCS 
Programs → Mate Programming Utility.  The following screen will appear.

5.	 From the main menu select CommPort, and click on the Com port that will be 
used for communication with the Mate. This will usually be Com 1 or Com 2.
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6.	 Click on the Continue button.

7.	 Select the Quick Mode unless any of the problems described on the image 
above have occurred.  A pop-up screen will then ask if the Mate is already 
programmed as a Mate or a Micromate.  This is because the key selections 
required to set up a Mate are different from setting up a Micromate.

8.	 Click the Mate or Micromate button as appropriate.  If the unit is already 
programmed as a Corrdata Mate, which is how new units are shipped, selecting 
the Mate command button will display the following instructions:
1. Connect Mate to COM Port 1 using Serial Adapter Cable
2. Turn on Mate
3. Press F1 (Read) on Mate
4. Press F2 (MODE) on Mate

If the unit is already programmed as a Micromate, the following instructions will 
be shown:

	 1. Connect Micromate to COM Port 1 using Serial Adapter Cable
	 2. Turn on Micromate
	 3. Press F4 on Micromate (one or two times) until F4 reads OK
	 4. Press F4 (OK) on Micromate
	 5. Press F4 (Mate) on Micromate
	 6. Press F2 (Prog/Mate) on Micromate
	
9.	 Follow the instructions above and then select the button to program the Mate 

as Mate or Micromate.  In this case the selection would be Make Micromate.
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A Scroll bar on the PC will indicate the progress of the programming and a scrolling 
of addressing being programmed on the Mate will show on the Mate screen.

Note:	 If the scroll bar operates on the PC but there is no 
scrolling of addresses on the Mate, then the Mate is not 
being programmed. This may be due to a bad connection 
or a wrong Com port.  The PC is not able to indicate such 
a problem as there is no error status communication 
between the PC and the Mate during programming.

The Mate will beep and indicate when the programming is complete.

10.	The programming of the Mate with the Micromate software also sets the Time 
Zone information into the Micromate automatically from the computer. The 
correct time zone is required as the underlying data format uses a GMT time 
reference.

Note 1:	 If using the Mate Programming Utility to set the 
Time Zone into the Micromate Software, make sure 
that the time on the computer is correct and that the 
Regional Settings in the Control Panel (Classic View) 
of Windows are correct.

Note 2:	 It is also possible to program the Time Zone manually 
on the Micromate on startup.

11.	Switch on the Micromate. The following screen will appear:

Micromate ver x.xx
Free Readings 24500
Mate Battery: OK
                                   More

The number of free readings should be 24500 if the Micromate memory is completely 
clear.  If the number is less than 24500, and previously collected data has already 
been transferred to the PC, then it is best to clear the memory to obtain maximum 
data collection capacity.  See step 13 below.  If the Battery indicates LOW then the 
Micromate batteries need changing.  Press More (F4).
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                Standard Time Zone
   |

GMT – 8.00
               DTZ     Up    Down    OK

If the Micromate has been programmed from the PC, and the PC is correctly setup 
for regional settings and time, then this screen should show the correct time zone 
with the number of hours from GMT (+ numbers of hours for locations East of 
London, - numbers of hours for locations West of London).  Standard Time Zone 
indicates there is no daylight savings.  Daylight Time Zone indicates that Daylight 
Savings Time is in operation.  If any of these settings are incorrect, check the 
computer and verify that the time and date settings are correct.  On the Micromate, 
the number of hours east or west of London may be changed with the Up (F3) and 
Down (F4) keys.  The Standard and Daylight Savings may be toggled with the F1 
key.  Press More (F4) to display the following screen.

ROHRBACK COSASCO
           SYSTEMS
                        Xfer
Read    Conf    Data    Mate

12.	To clear the data in the Mate, if required, press Mate (F4), and Clear Mate 
(F1).  A warning will appear.  Press Yes (F1) to complete memory clearance.

13.	Produce a listing of the configuration information for the data loggers.

14.	Connect the Micromate to the first data logger to be configured with the cables 
supplied.  From the Micromate main screen above press Conf (F2) to display 
the screen:

Set Data Logger ID
	          <      >

Enter   CLR   BkSp   More

15.	Enter the Logger # for the ID. This is the same as the Address # in the 
software. The Clear (F2) clears the complete entry. BkSp (F3) backspaces 
one character to enable correction.  Press Enter (F1) to complete the entry and 
navigate to the following screen:

Set Data Logger Tag
<              >

Enter    CLR   BkSp   More

16.	Enter the Tag number for this location, up to 12 characters, and press Enter 
(F1) to complete the entry and move to the next screen:
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Set Sample Rate
<     > minutes

Enter   CLR   BkSp   More

17.	Enter the Sample Rate or the reading frequency (required). For a data logger, 
where battery consumption is a consideration, a reading interval of 3 hours or 
180 minutes is usually well suited.  This gives a battery life of around one year 
and still provides eight readings a day. The minimum recommended setting is 
30 minutes.  The maximum setting is 1440 minutes (one day).  Press Enter 
(F1) to complete the entry.  This brings up the following screen:

Set D/L Clock
<                        >

YYMMDDHHMMSS
Enter    CLR   BkSp   More

18.	Enter the date and time in the format indicated in order to set the reference 
time into the data logger.  

YY is two digits for the year
MM is two digits for the month
DD is two digits for the day
HH is two digits for the hour (24 hour clock)
MM is two digits for the minute
SS is two digits for the seconds (or just enter 00)

Press Enter (F1) to complete the entry and configure the data logger. The 
Micromate will indicate configuration is in progress and then display the 
configured information such as follows:

ID: 01 CP 1003
Jul 7, 2006 13:30

Sample Rate
                                       Exit

Note:	 When configuring the data logger with the Micromate, it is 
not necessary to clear any data that may be left in the data 
logger.  This is done automatically by the Micromate.

19.	Leave the data logger to collect data.  It will take its first reading at the end of 
the sample period.

 
20.	Repeat steps 15 to 19 on the other data loggers that are to be configured.
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Data Collection from Data Loggers with Micromate

1.	 Connect the Micromate to the data logger communications port with the 
supplied cable.

Note:	 There are separate cables for the ML 9500A and the ML 
9500B.  Take care to use the correct cable. 

2.	 Switch on the Micromate, and press F4 twice to clear the initial screens.

3.	 Press Read (F1) to display the following screen:

ID: 25 CP 1002
Jul 7, 2006 13:30

Read  Read    Set
Stat    Data    Clock    Exit

4.	 If the battery on the data logger has expired, the Micromate will indicate that 
there is no communication.  In this case, change the data logger battery.  
When the battery runs low, the data logger will first switch off power to 
the transmitter, set the Battery Status to LOW, and stop taking readings.  
However, it will have enough power left for some time to allow communication 
with the Micromate.

WARNING:	 If the battery status indicates low, the data logger memory 
must be cleared after data collection to reset the Battery Low 
flag and re-enable reading of the transmitter. See step 5 below.  
If the memory is not reset, the data logger will not restart taking 
readings from the transmitter.

Note:	 Changing the data logger battery in a hazardous area will 
require a hot work permit; make sure the local atmosphere is 
free of explosive gases.

After replacing the battery, re-read the data logger as described in steps 2 and 3.  
Replacing the battery will require the data logger clock to be reset.  This will be 
indicated on the screen:

ID: 25 CP 1002
Clock Not Set!

  Read  Read    Set
Stat    Data    Clock    Exit

Press Set Time (F3) and enter the current date and time. Otherwise the default 
date is Jan 1, 2000.  This function is also used to correct the time in the data logger 
when required.

Set D/L Clock
<                    >

YYMMDDHHMMSS
Enter   CLR   BkSp   More
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Press Enter (F1) to show the screen in Step 3 above.

5.	 It is then important to press Read Stat (F1) to check the status of the data 
logger, specially the battery status. This would give a screen such as the 
following:

Jul 7, 2006 13:30
Readings: 245

Sample Rate: 180
More                               Exit

Press More (F1):
   Batt: OK (or Low)
   Mem: OK (or Bad)
   Trans: OK (or Bad)

                                      Exit

WARNING:	 If the battery status indicates Low,  collect the data in 
the data logger as described below, and then the data 
logger memory MUST be cleared (see step 8) to allow 
data collection to re-commence.

Memory Bad indicates a problem in the data logger memory requiring repair.

Transmitter Bad indicates that the data logger is not communicating 
with the transmitter. It suggests a problem with the interconnecting 
cable or transmitter.

	 Press Exit (F4) to return to the following screen:

ID: 25 CP 1002
Jul 7, 2006 13:35

Read   Read    Set
 Stat     Data     Clock    Exit

6.	 Press Read Data (F2) to commence collecting data.  If the data logger has not 
had its Logger # or ID set (for example if it was configured directly from a portable 
PC using the previous MS 9000 version 1.8 software), the Micromate will request 
setting of an ID (Address) and Tag.  If the data logger has already had the Logger 
# or ID set, then it will go directly to a screen similar to the following.

Data Logger ID: 01
Tag : CDL 1003

Start                               Exit

If there is insufficient memory for downloading the data, an error message “No 
Memory Space for Readings” will be displayed.  At this point the existing data in the 
Micromate will have to be transferred to the PC and the memory in the Micromate 
cleared. If the memory is sufficient, the Micromate will display the following:
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Getting Data
Please Wait

Approx   15.7 seconds (or mins)

The count-down screen will indicate how long it will take for the data transfer.

7.	 When data collection is complete, the screen will display the last reading, the 
date and time of the last reading, and the number of readings taken (shown 
below):

Last Reading +128586
July 7, 2006 13:30

Number Reads: 245
Clear                               Next

The last reading confirms that the instrument is producing good numbers.  If the 
reading is near +262144, the probe has almost expired and needs changing.  The 
data logger will need to be powered down and the probe replaced. Upon power-up, 
the data logger will need re-configuring to set the correct time and date.

8.	 Press Clear (F1) to clear the data memory in the data logger. This MUST be 
done if the Battery Status indicated LOW and the battery has been changed.  
If the battery has not been changed or do not wish to clear the memory, press 
Next (F4). 

9.	 Repeat steps 1 to 8 for each data logger from which data is to be collected.

Note:	 Clearing the data in the data logger minimizes the 
data collection time and maximizes the amount of data 
logger data that may be collected with the Micromate 
before it must be transferred to the PC.  The data 
logger will store up to 8000 readings before it stops 
recording.

Transferring Collected Data from Micromate to PC

1.	 Connect the Micromate to the PC communications port with the supplied cable.

2.	 Switch on the portable PC and start the Microcor Tools program.

3.	 From the Site/Communications tab in the Microcor Tools software, select 
the appropriate site from the Existing Sites area and set the Com Port # if 
necessary in the Data Logger Communications section, then press the Start 
command button.

4.	 On the Config/DL Transfer tab select the Address (data logger ID) of the first 
data logger for which information is to be collected from. 
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5.	 Switch on the Micromate and press (F4) twice to go to the main screen. Then 
press Xfer Data (F3). A screen such as the following will appear:

Data Logger ID: 01
Tag : CDL 1003

Start    Next   Prev    Exit

The first Data Logger # or ID will be the lowest number in the list.  Check that 
the Data Logger # or ID on the Micromate and the Address on the PC match. If 
not press Next (F2) or Prev (F3) until they do match.  Press Start (F1) and the 
following screen will be displayed:

Ready to Transfer
Data using Microcor
Software from RCS

                                    Exit

At this point the Micromate is emulating the selected data logger.

6.	 Click the Read Setup command button in the Data Logger section on the 
Microcor Tools software.  This will check if the communication port is valid and 
show the setup information.

The time and date shown in the Time and Date text field should correspond to the 
time the data was downloaded from the data logger.

The Battery text field should read OK.  If it reads Low, then the battery in the data 
logger should be changed and memory cleared.

The Sampling Interval text field in the Data Logger section should correspond to 
Sampling Interval text field in the Transmitter section.

Note:	 The Store Setup and Clear Data are not functional when 
working with the Micromate even though the status bar at 
the bottom of the screen indicates operation.  These are 
only operational when working directly with the PC and the 
data logger.  When using the Micromate, the configuration 
and clearing of the data logger is done by the Micromate.

7.	 Click the Read Data command button. If data from this location has already 
been collected, the following message appears:
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•	 Press Yes to add the new data onto an existing file.  This is the normal 
method if the data in the data logger is deleted after it is collected each time 
in order to speed data transfer.  It also prevents reaching the maximum 
storage capacity in the data logger at which time the data collection stops.

•	 Press No if all of the data in the Micromate is to replace an existing file. This 
should be used if the data in the data logger is NOT cleared each time it is 
read. In this case the existing file is automatically archived.

•	 Press Cancel to exit the Read Data function.

Note:	 The Microcor Data Logger will store up to 8000 readings before 
collection memory is fully allocated, then the collection of data 
will halt until data is cleared from memory.

After a selection has been made, a counter in the status bar indicates the number 
of samples to be transferred. Status bar will read End of Transfer when the data 
is successfully transferred from the data logger to the Microcor Tools program.

8.	 Verify that the data is transferred correctly - click the Show Data command 
button to display the data with the Microcor Tools – History Viewer.

9.	 At the end of the transfer, press Exit on the Micromate screen shown below:

Ready To Transfer
Data using Microcor
Software from RCS

                                        Exit

 This will return to the previous screen:

Data Logger ID: 01
Tag : CDL 1003

Start    Next   Prev    Exit

10.	Press Next (F2) to select the next Data Logger # or ID for data transfer from 
the Micromate to the PC. Select the corresponding Address on the PC and 
repeat steps 6 to 9 above.  Repeat these steps to transfer data from other data 
loggers.



MICROCOR® TOOLS  SOFTWARE VERSION 4.4.5 39

Note:	 An asterisk (*) after the ID number on the Micromate indicates 
that this ID has been transferred to the PC. This allows 
confirmation of which ID’s have been transferred and which 
have not.

11.	Clear the memory in the Micromate once all of the data is properly transferred 
and verified. This is done from the main screen shown below, by pressing Mate 
(F4) and Clear Mate (F1):

ROHRBACK COSASCO
SYSTEMS

      Xfer
Read    Conf    Data    Mate

The Micromate is once again ready for data collection from data loggers.

Note:	 The data logger checks the battery status during the maximum-
load time intervals. If the battery voltage is low, a battery Replace 
status is set in non-volatile memory. In this state the data logger 
does not power the transmitter and does not collect data. Other 
functions and commands such as Read Setup, Store Setup, 
Load Data, and Clear Data are not affected. The data logger 
will remain in this state until Clear Data command is executed 
after replacing the battery.

Configuration of Data Loggers with Checkmate DL

This section explains the manual configuration of Microcor probes (attached to a 
Microcor Data Logger) onto the Checkmate DL. Once the Microcor Data Logger 
information is properly configured into the Checkmate DL, Data Loggers will need 
to be programmed. See the Checkmate DL User Manual for more details.

Connect the Checkmate DL to the Microcor Data Logger; from the Standby display, 
press Conf (F2) to proceed to the Set Data Logger ID display:

Set Data Logger ID
<    >

Enter    Clr   BkSp    Exit

Enter a the desired ID number from 0 to 99 and press Enter (F1) to proceed to 
the Set Data Logger Tag display. If the ID selected has already been configured, 
the user will be notified; if continued with the configuration, all previously 
accumulated data will be erased from the Data Logger.

Enter Data Logger Tag
>                        <

Enter   Clr   BkSp  Exit
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In the Enter Data Logger Tag display, enter up to twelve (12) alpha/numeric 
characters to uniquely identify the monitoring location. This can be a tag number, 
location or process name.  Pressing Clr (F2) clears a previously entered ID.  
Pressing BkSp (F3) backs up one space for each time it is pressed so that a 
change can be made. Pressing Exit (F4) returns to the Standby display.

Press Enter (F1) to proceed to the Set Sample Rate display:

Set Sample Rate
>       < minutes

Enter    Clr    BkSp   Exit

Set the desired sample rate and press Enter (F1) to complete the configuration. 

Data Logger is successfully configured when the Checkmate DL displays the 
screen below. Date and Time settings are automatically programmed into the Data 
Logger using the programmed Checkmate DL time and date. Press Exit (F4) to 
return to the Standby screen from the following display: 

ID: XX XXXXXXXXXXX
MMM DD, YYYY HH:MM

Samp Rate: XXXX
                                      Exit

Note:	 It is necessary to set the correct DAYLIGHT or STANDARD 
time zone into the Checkmate DL to accurately Date and 
Time stamp Data Logger readings. Refer to the Available 
Memory Space and Standard Time Zone section of the 
Checkmate DL reference manual for more details.

If the following error message appears on the Checkmate DL during the Data 
Logger configuration, verify the Checkmate DL is properly connected to the Data 
Logger.

ERROR 
Error Reading Logger
Check Connections

                                             Exit

Set Data Logger Time

The Data Logger Date and Time is automatically set when the unit is configured 
using the Checkmate DL. However, it is possible to update or reset the time if 
required or if the display indicates “CLOCK NOT SET!”. To set the Data Logger 
Time and Date, connect the Checkmate DL to the Data Logger with the provided 
adapter cable connector. From the Standby screen, press Read (F1) to proceed 
to the following display with the attached Data Logger information:
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ID: XX  XXXXXXXXXXXX
MMM DD, YYYY   HH:MM
 Read    Read    Set

             Stat      Data    Clock    Exit

Press Set Clock (F3) to update the Data Logger with the set time of the 
Checkmate DL.

Note:	 It is necessary to set the correct DAYLIGHT or STANDARD 
time zone into the Checkmate DL to accurately Date and 
Time stamp Data Logger readings. Refer to the Available 
Memory Space and Standard Time Zone section of the 
Checkmate DL reference manual for more details.

Data Collection from Data Loggers with Checkmate DL

The Checkmate DL is designed to configure and gather data from all Microcor 
Data Loggers (ML 9500A and/or ML 9500B). The following section will explain the 
data collection procedure from Microcor Data Loggers. 

Read Data Logger Configuration and Status

Configurations already set into the Data Logger are easily read with the Checkmate 
DL. Connect the Checkmate DL to the Data Logger with the provided adapter 
cable connector.  From the Standby screen, press Read (F1) to proceed to the 
following display with the attached Data Logger information: 

ID: XX  XXXXXXXXXXXX
MMM DD, YYYY   HH:MM

Read    Read    Set
Stat      Data    Clock    Exit

Press Read Stat (F1) to display the Data Logger time, number of readings and the 
sample rate as shown below: 

MMM DD, YYYY HH:MM
   Readings: XXXXX

   Samp Rate: XXXXX
More                               Exit

Press More (F1) to continue to the next display which shows the battery, memory 
and transmission information as shown below. Battery status will show OK or 
LOW. Memory and Transmission will show OK or BAD depending on their status. 

Batt: OK/LOW
Mem: OK/BAD
Trans: OK/BAD

                                           Exit
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Reading / Clearing Data from Microcor Data Loggers

To read a Data Logger, connect the Checkmate DL to the Data Logger with the 
provided adapter cable connector. From the Standby screen, press Read (F1) to 
proceed to the following display with the attached Data Logger information:

ID: XX  XXXXXXXXXXXX
MMM DD, YYYY   HH:MM
Read    Read    Set
Stat      Data    Clock    Exit

Press Read Data (F2); Checkmate DL will perform a series of internal checks and 
proceed accordingly. First, Checkmate DL will check whether the ID is properly 
assigned. If the ID is not properly assigned, it will prompt the user to set the Data 
Logger ID and the Tag information. It will then determine if any readings for this ID 
are stored in the Checkmate DL. If any data for the ID exists in the Checkmate DL, 
then the user will be prompted to either Overwrite (F1) or Abort (F4).  Overwriting 
will delete the existing data for that ID and replace it with the new data being read. 
Once these internal checks are performed and any issues resolved, Checkmate 
DL will proceed to the following screen: 

Data Logger ID: XX
Tag: XXXXXXXXXXXX

 
Start                              Exit

Press Start (F1) from the above screen to begin the read process. The Checkmate 
DL will show the following screen during data transfer.

Getting Data
Please Wait

Approx XX.X minutes

If “NO MEMORY SPACE FOR READINGS” screen appears (shown below), then 
the Checkmate DL memory will need to be cleared before transferring the data. It 
is recommended that ALL existing data on the Checkmate DL be transferred to a 
PC prior to erasing ANY data.  Refer to the section on Clearing the Checkmate 
DL Memory on the Checkmate DL reference manual.

NO MEMORY SPACE
FOR READINGS

                                          Exit

Once the data is successfully read and transferred, it is displayed as shown below. 
Users can at this time elect to delete the Data Logger content if desired.

Note:	 All data stored for the ID on the Checkmate DL will 
be erased if “Clear” button is pressed. 
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Press Clear (F1) to clear Data Logger readings or Next (F4) to return back to the 
Data Logger information screen without clearing the readings.

Last Reading xxxxxxx
MMM DD, YYYY  HH:MM
Number Reads  XXXXX

Clear                            Next

WARNING! It is recommended to clear the data in the Data Logger 
after transfer to the Checkmate DL. This reduces the amount 
and time of data transfer for future downloads. The data is then 
appended to the previous data when transferring the data from the 
Checkmate DL to the PC. Refer to the Transferring Collected 
Data from Checkmate DL to PC section.

Transferring Collected Data from Checkmate DL to PC

Data Logger data is downloaded to the PC using the provided Microcor Tools 
Software program. Connect the Checkmate DL instrument to the 9 pin serial port 
on the PC using the provided cable. If there is no serial port in the computer, use 
the included serial-to-USB converter cable to complete the connection. Make sure 
to set the correct COM port number on the Microcor Tools Software program Data 
Logger Communication area (in most cases this will be COM 1, however verify 
this in the device manager).

Checkmate DL Data Transfer Procedure

From the Standby screen, press Data (F3) to advance to the following display:

Transfer Data
Connect to PC

Start                             Exit

Press the Start (F1) to proceed to the next screen. Use Next (F2) and Prev (F3) 
to navigate the ID list (0 – 99) and select the desired ID to transfer data (shown 
below).

Data Logger ID: XX
Tag: XXXXXXXXXXXX

Start    Next    Prev    Exit

Once the ID is selected, press Start (F1). Following screen will appear:

Ready to Transfer
Data using Microcor
Software from RCS

                                        Exit
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Note:	 Make sure that the data (ID of the Data Logger) set in 
the Checkmate DL to be transferred corresponds with 
the Address selected in the Microcor Tools Software 
before transferring the data.

Data is now ready for transfer from the Checkmate DL to the PC. On the Microcor 
Tools Software program, select the Site and navigate to the Config/DL Transfer 
screen, select the Address and choose Data Logger as the Connection type and 
Microcor as the Instrument (see image below). Click the Read Data command 
button to begin the transmission. It is also possible to click the Read Setup 
command button to transfer the configuration data of the Data Logger to the Data 
Logger section on the Config/DL Transfer screen (shown below).

If data already exists for the chosen address, following dialogue box will appear:

•	 Press Yes to add the new data onto an existing file.  This is the normal 
method if the data in the data logger is deleted after it is collected each time 
in order to speed data transfer.  It also prevents reaching the maximum 
storage capacity in the data logger at which time the data collection stops.

•	 Press No if all of the data in the Checkmate DL is to replace an existing file. 
This should be used if the data in the data logger is NOT cleared each time 
it is read. In this case the existing file is automatically archived.
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•	 Press Cancel to exit the Read Data function.

Note:	 The Microcor Data Logger will store up to 8000 readings 
before collection memory is fully allocated, then the 
collection of data will halt until data is cleared from memory.

After a selection has been made, a counter in the status bar indicates the number 
of samples to be transferred. Status bar will read End of Transfer when the data 
is successfully transferred from the data logger to the Microcor Tools program. 
During the data transfer, the following screen will be displayed on the Checkmate 
DL:

Data Transfer in
Progress!
xxxxx Readings Left
                                             Exit

The number of readings (xxxxx) counts down as the data is transferred to Microcor 
Tools. Upon successful transmission, Checkmate DL will show the following screen: 

Data Transfer Done!

                                           Exit

Press Exit (F4) to return to the Data Transfer screen to choose another ID for data 
transfer. 

Note:	 Information from only one Data Logger can be 
transferred at a time, when transferring information 
of more than one Data Logger, change the Address 
on the Microcor Tools Software program for each 
transfer so that all data is not transferred only to one 
ID address.

In case of any error messages displayed on Checkmate DL, check connections 
between Checkmate DL and the PC, make sure that Microcor Tools Software 
program is running and that the correct COM port is selected.

If data is still not transferred after checking the connection between the PC and 
Checkmate DL, please see the Troubleshooting section for further help.
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Retrieving and Plotting Data 
(History Viewer) CHAPTER 5

Microcor Tools allows retrieving and plotting of corrosion data. Microcor Tools 
– History Viewer can be used to view data collected Online or by Data Logger 
connection methods.

To open the Microcor Tools – History Viewer (graph feature), select the site from 
the Site/Communications tab, select the Address from the Config/DL Transfer 
tab, and click the Show Data command button. Alternate method to enter the 
History Viewer is to navigate to the Data Display tab and double-clicking the Tag 
of the desired unit.

Microcor Transmitters (MT 9485, MT 9485A)

In the above screen, the top graph is the Metal Loss and the bottom graph 
presents the probe Temperature (when applicable).  The bottom graph can be 
switched to show the Corrosion or Erosion Rate for the same set of data when 
the Corrosion or Erosion Rate button is selected. 
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To show the corrosion rate graph, click the Corrosion or Erosion Rate command 
button (see section below for more details). Click the Temperature command 
button to display the probe temperature graph.

Note:	 The Temperature graph will open as the default bottom graph 
if the transmitter supports temperature monitoring capabilities 
and if the Probe Temperature check-box is selected; otherwise 
the graph area will remain blank (to view the Corrosion or 
Erosion Rate graph, Corrosion or Erosion Rate command 
button must be pressed. It will not open as a default graph). 
Data loggers do not support temperature measurements.

Use the upper Dimension box (top right-hand corner of the screen) to select the 
Metal Loss Y-axis units in mils, µm, mm or Probe Life Units (PLU). Use the 
lower Dimension box (middle right-hand side of the screen) to select units for 
the Temperature graph in ºC or ºF or mpy, mmpy or µmpy units if Corrosion or 
Erosion Rate graph is selected.

Corrosion/Erosion Rate is calculated by linear regression. This Regression Interval 
may be re-adjusted and the Corrosion/Erosion Rate recalculated by clicking the 
Recalculate command button. The default may suit many online systems but can 
be changed to optimize noise against sensitivity of the computed corrosion or 
erosion rate. The 24h Filter can be enabled at the Rate/Alarms Settings area (in 
the Config/DL Transfer screen) to reduce the effects of any diurnal (24) thermal 
noise. The Alarm Level units are directly related to the above selected units and 
can only be changed by the above settings. 

Once the settings have been optimized, the rate data may be saved with the Store 
button. When closing the graphical display window (History Viewer) a dialog box 
will prompt to save the settings. Select Yes to store these settings for automatic 
application to all new data.
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Select (or type in) values for Zero and Gain to calibrate the measurement. If 
calibration parameters are unknown for probes and transmitters, select 0 for Zero 
and 31 for Gain.

The Zero Offset will allow users to change the y-axis reference point to zero 
(0) by changing the value. This is a helpful feature when conducting tests to 
graphically view the data from a convenient starting point. It is recommended that 
this be returned to original value of zero so determination of probe life can be done 
accurately.

E9020 Transmitter (E9020)

The E9020 transmitter operates with Corrater probes configured with the same 
alloy electrodes. In this mode, both corrosion rate and pitting tendency (or 
imbalance) is measured. When the probe has Galvanic electrodes installed, only 
the pitting tendency (or imbalance) measurement is used providing an indication of 
Galvanic current. Most commonly this measurement is used in sea-water injection 
systems where de-aeration is used to prevent corrosion by keeping oxygen levels 
to typically less than 20 ppb (parts per billion). At these low levels of oxygen the 
galvanic current is linearly related to the oxygen (or dissolved gasses) level. 

Corrater Probes

The data for Corrosion Rate and Pitting Tendency is shown in one graph for 
Corrater probes with standard electrodes of the same alloy. 
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The Corrosion Rate graph is painted black and the Pitting graph is painted blue. 
Use the Dimension box (center right-hand corner of the screen) to select the 
Corrosion Rate units in mpy, mmpy, or μmpy. Pitting tendency does not have 
units of measure but is interpreted in magnitude to the corrosion rate reading. 
When the pitting tendency reading is greater than the corrosion rate and erratic in 
value, this is indicative of pitting type corrosion. Under general corrosion conditions, 
the pitting tendency shows values much lower than the corrosion rate value and 
typically be near zero. For ease of interpretation the units of pitting tendency are 
set to match the corrosion rate units. The graph above shows a pitting reading 
about half the value of the corrosion rate reading indicating generally little pitting. 
The graph below shows just the corrosion rate with pitting de-selected.

Galvanic Probes

When using Galvanic electrodes, only the pitting (or imbalance) graph is generated. 
Imbalance units can be switched between Galvanic current in microamperes (μA) 
or in part per billion (ppb) of oxygen based on an approximate empirical calibration 
of 4 μA per ppb of oxygen. Typical Galvanic graph is shown below:
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Zoom Commands

To select a zoom area:
1.	 Navigate to the graph, press and hold the left mouse button on the starting 

location.
2.	 Move the mouse horizontally and release the button at the desired end location.
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Use the UndoZoom command button to return to the previous state of the graph.

Note:	 UndoZoom command button will only undo the last 
nine (9) graphical zoom changes and will adjust the 
Y-axis unit range to match the maximum ranges of 
the graphs. Click the Reload Graphs to return to the 
original graphs.

The zoom result from the above graph is shown below:

Smoothing is a process by which data points are averaged with their neighbors 
in a series to blur the sharp edges to depict smoother data points. At the default of 
zero, it plots every data point. The setting is the number of points used in a moving 
average to smooth the Metal Loss data. The maximum setting number is 100. 
Increase and decrease the number for more or less smoothing of graphs.

Note:	 This setting does not affect the data used for the 
Corrosion or Erosion Rate computation, since it is 
computed from the raw data.

Generating a Corrosion or Erosion Rate Graph for Microcor Transmitters

To generate a graph of Corrosion or Erosion Rate against time, press the 
Corrosion or Erosion Rate command button. 
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The Regression Interval [h] control allows selecting a time interval used to 
calculate the Corrosion or Erosion Rate graph (linear regression algorithm).

The Corrosion/Erosion Rate will be in units corresponding to the Metal Loss units 
that have been selected in Mils per Year (mpy), Millimeters Per Year (mmpy) or 
Micrometers per Year (µmpy), and will be calculated by linear regression on an 
initial default-running-window of 24 hours (20 hours when the collection time is 
set to 2 minute intervals). This regression period is displayed in hours and may be 
re-adjusted and the Corrosion/Erosion Rate re-run with the Corrosion or Erosion 
Rate command button.  The interval may need adjustment to optimize noise versus 
sensitivity of the rate graph. 

The Corrosion/Erosion Rate graph is computed from the metal loss data by 
determining the slope of the best straight line through the metal loss data.  The best 
straight line is computed statistically by the method known as linear regression.  For 
example if we have 7 days of metal loss data, we may typically want to calculate 
the slope or corrosion/erosion rate based on a moving 1 days worth of data.  In this 
case, the first corrosion/erosion rate data point is produced after the first one day’s 
worth of data.  So for 7 days worth of metal loss data there is only 6 days worth of 
corrosion/erosion rate data.  That is, the corrosion/erosion rate data will always be 
less than the metal loss data by the amount of the regression period.
 
The corrosion/erosion rate essentially represents the tangent to the metal loss 
curve.  So if we use 1 day’s worth of metal loss data for computation, then the 
corrosion/erosion rate value is calculated from half the regression period before and 
half the regression period after that time.  Consequently with 7 days of metal loss 
data, the 6 days of corrosion/erosion rate data starts time-wise with ½ day blank at 
the beginning and ½ day blank at the end of the 7 day period.  In fact, the Microcor 
Tools graph will show a horizontal line on the graph at each of these locations 
equal to the starting and ending corrosion/erosion rate values respectively.
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Data Cursor

The Data Cursor function provides information for an individual data point. The 
Enable command button marks the data points on the graph with dots. Mouse 
clicking on the data point will refresh the Metal Loss, Temperature/Corrosion 
Rate (depending on the graph selected) and Time readings on the gray bar located 
at the bottom section of the graph. To disable the Data Cursor function, click the 
Disable command button.

Point to Point Calculations

This function provides metal loss and corrosion rate calculation for a selected 
time-interval.

•	 Click on the Show Selection command button. 
-Two vertical lines (red and green) will appear on the screen.

•	 Click and drag the lines to the desired positions on the graph.
•	 Click the Corr. Rate or Metal Loss command buttons for the calculations to 

appear on the gray bar located at the bottom section of the graph.

Click the Hide command button to disable this feature.
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Live Update Graphing

When entering the Microcor Tools – History Viewer, the Metal Loss and 
Temperature (when applicable) graph(s) are loaded by default for the Microcor 
Transmitters and Imbalance and Corrosion Rate graphs are loaded for the E9020 
Transmitters. These are static graphs where previously collected data stored in 
the Microcor Tools Software are loaded and displayed. It is possible to graphically 
display real-time data on systems with enabled online data collection (Start the 
Online Communication and Data Collection on the Site/Communications 
screen). 

Zoom to the desired area of the graph and click the Start command button of 
the Live Update. The software will calculate the number of data points within the 
zoomed area and display that number of most recent data points and activate 
the real-time data update. It will invoke the data file every two minutes to obtain 
any newly collected data points and with each new data point update, it will drop 
the last (trailing) data point.  Live Update displays raw, non-smoothed data. 
Alternatively, it is possible to click the Start command button of the Live Update 
prior to zooming to limit the display to the most recent 100 data points. It is 
possible to keep zooming-in while in Live Update mode, however, UndoZoom, 
Smoothing, switching between Temperature and Corrosion Rate, Recalculate 
and Store features are disabled. Choosing to Stop, Reload Graphs, Enable 
the Data Cursor or Show the Selection Lines will disable the Live Update and 
enable the previously disabled features.
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The Corrosion/Erosion Rate graph is computed from the metal loss data by 
determining the slope of the best straight line through the metal loss data.  The 
best straight line is computed statistically by the method known as linear regression 
(this is further explained above in the Generating a Corrosion or Erosion Rate 
Graph section.  

With on-line systems future data to use in computations is unavailable.  So latest 
computed corrosion/erosion rate is really the value for half the regression period 
prior to the current time.  In the absence of the future data it is assumed that 
this is also the best estimate of the current corrosion/erosion rate, and hence the 
horizontal line on the graph over this period (at the beginning and end of the graph).

When Live Update is activated, the rate graph is purposely shifted forward by half 
the regression period so that the latest computed corrosion rate value is shown 
at the present time.  This makes it easier to view the metal loss and the best 
computed corrosion/erosion rate for the current time when zoomed-in. In the case 
of 7 days worth of metal loss data, this means that the 6 days of corrosion rate data 
will now be positioned with a blank period of 1 day at the start of the 7 days and no 
blank period at the end of the 7 days.

Note:	 If data is imported using the Load from Archives 
feature, ensure the Transmitter Sampling Interval is 
set to the original settings to obtain accurate number of 
data points when Live Update is used with the zoom 
feature.
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Generating a Status Report

The history file that contains all the corrosion data also contains status codes. 
These status codes are not shown by the Microcor Tools – History Viewer 
graphs. The Status Report command button is intended to search the history file 
for status codes and to generate a report in standard text format. The command 
opens the report in the Notepad editor.

Use the Notepad “Print” or “Save As” commands to print or store the report on 
the hard drive.
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Real-Time Data Monitoring CHAPTER 6

The Data Display tab is the most convenient global display for on-line systems. It 
shows current readings, alarm status codes and which addresses are data loggers. 
Each point on the Data Display maybe double-clicked to show the graphical display 
(History Viewer). This screen allows for monitoring and troubleshooting of RS485 
bus and transmitters. Communication errors and transmitter status codes are listed 
in the Transmitter Status column while the column named Parameter 3 will turn 
red if a unit is in alarm status. It will turn yellow when the alarm is acknowledged by 
the user; yellow means there is an ongoing alarm and it is acknowledged. When 
the alarm is turned off or when the corrosion rate resets to below the alarm rate, 
the column will return to normal. If a unit enters an alarm status and resets prior to 
user acknowledgement, red indicator will change color to blinking green and gray 
(on the bottom status bar of the screen) and will log this on the Event Log.
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Event Log CHAPTER 7

The Event Log tab is intended to collect and store different types of events 
in the system and to present them in a table format. The events are stored 
in a 500 element buffer.  The Save button permits export of the event log 
information in to a text-format file. If a unit enters an alarm status and resets 
prior to user acknowledgement, red indicator will change color to blinking 
green and gray (on the bottom status bar of the screen) and will log this 
on the Event Log; hence it is highly recommended that the Event Log is 
inspected regularly.
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Archiving and Importing Data CHAPTER 8

Collected data may be archived when the data files become large enough to 
slow down the graphing function, typically over 65,000 points.  Data may also be 
retrieved from archives into the program, and this function may also be used to 
import data files such as those from the previous versions of the Microcor software 
or from other Microcor Tools software users.

Archiving Data

When moving data to the archives, this data is always stored in the Archives 
folder. The path is as follows; C:\Program Files\Microcor Tools\data\Site Name\
archives.

To archive a data file, select the Address to be archived and press the Move to 
Archives command button. Each time a file is archived, the date is added to the 
file name to prevent overwriting of any earlier dated file.  This protection function 
does not operate if the data has the same date, therefore, archiving is permitted 
only once per day.
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Archive files have automatically assigned names. For example, the archive file of 
location Address 15, created on 13 May, 2003 is ch15_13May03.dat.  The same 
address archived the following day would be ch15_14May03.dat. 

Note:	 The naming convention used for archiving allows 
only one archive per day.

Importing Archived Data

To retrieve an archived file, press the Load from Archives command button. The 
default opening location of the browse box will be the Archives folder.

To import data from some other data files such as those from the previous versions 
of Microcor or from other Microcor Tools users, browse to the required file and 
select the Open button.

Data files (*.DAT) can be imported from other Microcor Tools users or previous 
versions of Microcor Tools. However, these files do not contain user specified 
details as probe span and probe reading interval. This information will need to be 
manually entered on the Config/DL Transfer screen to accurately process the 
data for display and calculations. This information can be found in the source data 
file (*.SET); probe reading interval can also be found on the graph by clicking the 
Enable on the Data Cursor and checking the reading interval.

Auto Archiving

The Auto Archiving feature in the main screen is designed for computers with 
limited storage resources. If the Auto Archiving is selected, when a site collects 
2MB of data (approximately 48,620 readings or 67 days of continuous data collection 
(temperature data collection enabled) at a sampling interval of 2 minutes), the data 
file is automatically transferred into the archives folders replacing previously stored 
data file. Naming convention of these archive files are different compared to use 
instigated archive file. For example, the archive file of location Address 15 is ch15.
dat.

Note:	 When Auto Archiving is enabled, Microcor Tools 
initiates automatic archiving when the file reaches its 
limit, previous automatically stored archives will be 
deleted. This process will not delete any manually 
archived files.
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Alloy Multipliers Appendix A

These factors are recommended for use with the E9020 instrument.  They are 
based upon use of CORRATER® electrodes which have surface areas of 5cm2 for 
“standard” probes and 0.5 cm2 for “flush” probes.

UNS Code Material Multiplier
K03005 Pipe Grade Carbon Steel 1.00
A91100  Aluminum 1100-0 0.94
A92024  Aluminum 2024 0.88
C11000  Copper 110 ETP Comm. Pure 2.00
C44300  CDA 443 Arsenical Admiralty 1.67
C44500  CDA 445 Phosphorized Adm. 1.68
C64200  CDA 642 A1 Silicon Bronze 1.48
C68700  CDA 687 Alum. Brass Arsenical 1.62
C70610 CDA 706 90/10 Copper/Nickel 1.80
C71500  CDA 715 70/30 Copper/Nickel 1.50
G41300 AISI 4130 Alloy Steel 1.00
L50045 Lead 2.57
N04400 Monel 400 Nickel 1.13
N05500 Monel K-500 Nickel 1.04
N06022 Hastelloy C22 0.85
N06600 Inconel 600 Nickel 0.95
N08020 Carpenter 20 CB3 SST 0.98
N08800 Incolloy 800 0.89
N08825 Incolloy 825 0.88
N10276 Hastelloy C276 0.86
R50400 ASTM B-348 Grades 2-4 Titanium 0.75
S30400 AISI 304 Stainless Steel 0.89
S31600 AISI 316 Stainless Steel 0.90
S31603 AISI 316L Stainless Steel 0.90
S31803 2205 Duplex Stainless Steel 0.89
S32750 2507 Duplex Stainless Steel 0.88
Z17001 Grades 1A, 1, 2, 3, or 5 Zinc 1.29
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Modbus Configuration Appendix B

Modbus Slave ID: 1													           
Modbus Data Type: Float 32 	  Customer:	  Gas Company		  Purchase Order:				 
				     Sales Order:	 80829			   Rev F	   7/22/2008        Ref System Diagram Rev F

     Microcor Transmitters - Model MT-9485A Corrater / Galvanic Transmitter - Model E-9020

Trx
Address 

(I/N)

Metal
Loss
(mils)

Temp
Change

(F)

Calc
Rate
(mpy

Calc 
Rate w/
24h filter

(mpy)

Status Trx
Address

(I/N)

Pitting
(no units)

or Galvanic
(uA)

Corrosion
Rate /

Potential
(mpy)

Reserved Reserved Status

Description Trx
Comm
Port

Tag
Number

Range 
1

Range 
2

Modbus
Address

Modbus
Address

Modbus
Address

Modbus
Address

Modbus
Address

Modbus
Address

Modbus
Address

Modbus
Address

Modbus
Address

Modbus
Address

0 40,001 40,003 40,005 40,007 40,009 0 40,001 40,003 40,005 40,007 40,009

1 40,011 40,013 40,015 40,017 40,019 1 40,011 40,013 40,015 40,017 40,019

2 40,021 40,023 40,025 40,027 40,029 2 40,021 40,023 40,025 40,027 40,029

3 40,031 40,033 40,035 40,037 40,039 3 40,031 40,033 40,035 40,037 40,039

4 40,041 40,043 40,045 40,047 40,049 4 40,041 40,043 40,045 40,047 40,049

5 40,051 40,053 40,055 40,057 40,059 5 40,051 40,053 40,055 40,057 40,059

6 40,061 40,063 40,065 40,067 40,069 6 40,061 40,063 40,065 40,067 40,069

7 40,071 40,073 40,075 40,077 40,079 7 40,071 40,073 40,075 40,077 40,079

8 40,081 40,083 40,085 40,087 40,089 8 40,081 40,083 40,085 40,087 40,089

9 40,091 40,093 40,095 40,097 40,099 9 40,091 40,093 40,095 40,097 40,099

10 40,101 40,103 40,105 40,107 40,109 10 40,101 40,103 40,105 40,107 40,109

11 40,111 40,113 40,115 40,117 40,119 11 40,111 40,113 40,115 40,117 40,119

12 40,121 40,123 40,125 40,127 40,129 12 40,121 40,123 40,125 40,127 40,129

13 40,131 40,133 40,135 40,137 40,139 13 40,131 40,133 40,135 40,137 40,139

14 40,141 40,143 40,145 40,147 40,149 14 40,141 40,143 40,145 40,147 40,149

15 40,151 40,153 40,155 40,157 40,159 15 40,151 40,153 40,155 40,157 40,159

16 40,161 40,163 40,165 40,167 40,169 16 40,161 40,163 40,165 40,167 40,169

17 40,171 40,173 40,175 40,177 40,179 17 40,171 40,173 40,175 40,177 40,179

18 40,181 40,183 40,185 40,187 40,189 18 40,181 40,183 40,185 40,187 40,189

19 40,191 40,193 40,195 40,197 40,199 19 40,191 40,193 40,195 40,197 40,199

20 40,201 40,203 40,205 40,207 40,209 20 40,201 40,203 40,205 40,207 40,209

21 40,211 40,213 40,215 40,217 40,219 21 40,211 40,213 40,215 40,217 40,219

22 40,221 40,223 40,225 40,227 40,229 22 40,221 40,223 40,225 40,227 40,229

23 40,231 40,233 40,235 40,237 40,239 23 40,231 40,233 40,235 40,237 40,239

24 40,241 40,243 40,245 40,247 40,249 24 40,241 40,243 40,245 40,247 40,249

25 40,251 40,253 40,255 40,257 40,259 25 40,251 40,253 40,255 40,257 40,259

26 40,261 40,263 40,265 40,267 40,269 26 40,261 40,263 40,265 40,267 40,269

27 40,271 40,273 40,275 40,277 40,279 27 40,271 40,273 40,275 40,277 40,279
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28 40,281 40,283 40,285 40,287 40,289 28 40,281 40,283 40,285 40,287 40,289

29 40,291 40,293 40,295 40,297 40,299 29 40,291 40,293 40,295 40,297 40,299

30 40,301 40,303 40,305 40,307 40,309 30 40,301 40,303 40,305 40,307 40,309

31 40,311 40,313 40,315 40,317 40,319 31 40,311 40,313 40,315 40,317 40,319

32 40,321 40,323 40,325 40,327 40,329 32 40,321 40,323 40,325 40,327 40,329

33 40,331 40,333 40,335 40,337 40,339 33 40,331 40,333 40,335 40,337 40,339

34 40,341 40,343 40,345 40,347 40,349 34 40,341 40,343 40,345 40,347 40,349

35 40,351 40,353 40,355 40,357 40,359 35 40,351 40,353 40,355 40,357 40,359

36 40,361 40,363 40,365 40,367 40,369 36 40,361 40,363 40,365 40,367 40,369

37 40,371 40,373 40,375 40,377 40,379 37 40,371 40,373 40,375 40,377 40,379

38 40,381 40,383 40,385 40,387 40,389 38 40,381 40,383 40,385 40,387 40,389

39 40,391 40,393 40,395 40,397 40,399 39 40,391 40,393 40,395 40,397 40,399

40 40,401 40,403 40,405 40,407 40,409 40 40,401 40,403 40,405 40,407 40,409

41 40,411 40,413 40,415 40,417 40,419 41 40,411 40,413 40,415 40,417 40,419

42 40,421 40,423 40,425 40,427 40,429 42 40,421 40,423 40,425 40,427 40,429

43 40,431 40,433 40,435 40,437 40,439 43 40,431 40,433 40,435 40,437 40,439

44 40,441 40,443 40,445 40,447 40,449 44 40,441 40,443 40,445 40,447 40,449

45 40,451 40,453 40,455 40,457 40,459 45 40,451 40,453 40,455 40,457 40,459

46 40,461 40,463 40,465 40,467 40,469 46 40,461 40,463 40,465 40,467 40,469

47 40,471 40,473 40,475 40,477 40,479 47 40,471 40,473 40,475 40,477 40,479

48 40,481 40,483 40,485 40,487 40,489 48 40,481 40,483 40,485 40,487 40,489

49 40,491 40,493 40,495 40,497 40,499 49 40,491 40,493 40,495 40,497 40,499

50 40,501 40,503 40,505 40,507 40,509 50 40,501 40,503 40,505 40,507 40,509

51 40,511 40,513 40,515 40,517 40,519 51 40,511 40,513 40,515 40,517 40,519

52 40,521 40,523 40,525 40,527 40,529 52 40,521 40,523 40,525 40,527 40,529

53 40,531 40,533 40,535 40,537 40,539 53 40,531 40,533 40,535 40,537 40,539

54 40,541 40,543 40,545 40,547 40,549 54 40,541 40,543 40,545 40,547 40,549

55 40,551 40,553 40,555 40,557 40,559 55 40,551 40,553 40,555 40,557 40,559

56 40,561 40,563 40,565 40,567 40,569 56 40,561 40,563 40,565 40,567 40,569

57 40,571 40,573 40,575 40,577 40,579 57 40,571 40,573 40,575 40,577 40,579

58 40,581 40,583 40,585 40,587 40,589 58 40,581 40,583 40,585 40,587 40,589

59 40,591 40,593 40,595 40,597 40,599 59 40,591 40,593 40,595 40,597 40,599

60 40,601 40,603 40,605 40,607 40,609 60 40,601 40,603 40,605 40,607 40,609

61 40,611 40,613 40,615 40,617 40,619 61 40,611 40,613 40,615 40,617 40,619

62 40,621 40,623 40,625 40,627 40,629 62 40,621 40,623 40,625 40,627 40,629

63 40,631 40,633 40,635 40,637 40,639 63 40,631 40,633 40,635 40,637 40,639

64 40,641 40,643 40,645 40,647 40,649 64 40,641 40,643 40,645 40,647 40,649

65 40,651 40,653 40,655 40,657 40,659 65 40,651 40,653 40,655 40,657 40,659

66 40,661 40,663 40,665 40,667 40,669 66 40,661 40,663 40,665 40,667 40,669

67 40,671 40,673 40,675 40,677 40,679 67 40,671 40,673 40,675 40,677 40,679

68 40,681 40,683 40,685 40,687 40,689 68 40,681 40,683 40,685 40,687 40,689

69 40,691 40,693 40,695 40,697 40,699 69 40,691 40,693 40,695 40,697 40,699

70 40,701 40,703 40,705 40,707 40,709 70 40,701 40,703 40,705 40,707 40,709

71 40,711 40,713 40,715 40,717 40,719 71 40,711 40,713 40,715 40,717 40,719

72 40,721 40,723 40,725 40,727 40,729 72 40,721 40,723 40,725 40,727 40,729

73 40,731 40,733 40,735 40,737 40,739 73 40,731 40,733 40,735 40,737 40,739
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74 40,741 40,743 40,745 40,747 40,749 74 40,741 40,743 40,745 40,747 40,749

75 40,751 40,753 40,755 40,757 40,759 75 40,751 40,753 40,755 40,757 40,759

76 40,761 40,763 40,765 40,767 40,769 76 40,761 40,763 40,765 40,767 40,769

77 40,771 40,773 40,775 40,777 40,779 77 40,771 40,773 40,775 40,777 40,779

78 40,781 40,783 40,785 40,787 40,789 78 40,781 40,783 40,785 40,787 40,789

79 40,791 40,793 40,795 40,797 40,799 79 40,791 40,793 40,795 40,797 40,799

80 40,801 40,803 40,805 40,807 40,809 80 40,801 40,803 40,805 40,807 40,809

81 40,811 40,813 40,815 40,817 40,819 81 40,811 40,813 40,815 40,817 40,819

82 40,821 40,823 40,825 40,827 40,829 82 40,821 40,823 40,825 40,827 40,829

83 40,831 40,833 40,835 40,837 40,839 83 40,831 40,833 40,835 40,837 40,839

84 40,841 40,843 40,845 40,847 40,849 84 40,841 40,843 40,845 40,847 40,849

85 40,851 40,853 40,855 40,857 40,859 85 40,851 40,853 40,855 40,857 40,859

86 40,861 40,863 40,865 40,867 40,869 86 40,861 40,863 40,865 40,867 40,869

87 40,871 40,873 40,875 40,877 40,879 87 40,871 40,873 40,875 40,877 40,879

88 40,881 40,883 40,885 40,887 40,889 88 40,881 40,883 40,885 40,887 40,889

89 40,891 40,893 40,895 40,897 40,899 89 40,891 40,893 40,895 40,897 40,899

90 40,901 40,903 40,905 40,907 40,909 90 40,901 40,903 40,905 40,907 40,909

91 40,911 40,913 40,915 40,917 40,919 91 40,911 40,913 40,915 40,917 40,919

92 40,921 40,923 40,925 40,927 40,929 92 40,921 40,923 40,925 40,927 40,929

93 40,931 40,933 40,935 40,937 40,939 93 40,931 40,933 40,935 40,937 40,939

94 40,941 40,943 40,945 40,947 40,949 94 40,941 40,943 40,945 40,947 40,949

95 40,951 40,953 40,955 40,957 40,959 95 40,951 40,953 40,955 40,957 40,959

96 40,961 40,963 40,965 40,967 40,969 96 40,961 40,963 40,965 40,967 40,969

97 40,971 40,973 40,975 40,977 40,979 97 40,971 40,973 40,975 40,977 40,979

98 40,981 40,983 40,985 40,987 40,989 98 40,981 40,983 40,985 40,987 40,989

99 40,991 40,993 40,995 40,997 40,999 99 40,991 40,993 40,995 40,997 40,999

100 41,001 41,003 41,005 41,007 41,009 100 41,001 41,003 41,005 41,007 41,009

Protocol
•	 Hardware output is RS-485 2 wire: Software output is settable ASCII or 

RTU, Default setting is 19200 Baud, 8 data bits, 1 stop bits, no parity

Scaling
•	 All outputs are scaled in engineering units as configured in the Microcor 

Tools with Output Interfaces software running on the IIU
•	 Error Codes from Microcor transmitters will produce large negative num-

bers in the applicable Modbus registers approx 3.8 times the probe span in 
engineering units set i.e for Microcor 5 mil span probe error codes typically 
around - 19.07

•	 Error Codes from E-9020 Corrater / Galvanic Transmitter will also pro-
duce large negative numbers in the applicable Modbus registers of approx. 
-762,935 on mpy units
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Status Field for Microcor
Status 1 - 2 Bytes

Bit 0 Metal Loss Status     (1=OK) Bit 0=1 if Bit 8=0, and Bit 9=0, and Bit 10=0
Bit 1 Temperature Status   (1=OK)
Bit 2 Corrosion Rate Linear Regression   (1=OK)
Bit 3 Corrosion Rate with 24 hr filter   (1=OK) 
Bit 4 Not Used
Bit 5 Not Used
Bit 6 Not Used
Bit 7 Not Used
Bit 8 Transmitter to IIU communication error (1=Error)
Bit 9 Transmitter in Startup  (1=StartUp) 
Bit 10 Probe or Probe Connection Failure (1=Failure) 
Bit 11 Not Used
Bit 12 Not Used
Bit 13 Not Used
Bit 14 Not Used
Bit 15 Not Used
Status 2 - 2 Bytes
Reserved

Status Field for E-9020
Status 1 - 2 Bytes

Bit 0 Measurement Status (1=OK) Bit 0=1 if all Bits 8 to Bit 13 are =0
Bit 1 Not Used
Bit 2 Not Used
Bit 3 Not Used
Bit 4 Corrosion Rate Alarm (1=in alarm)
Bit 5 Not Used
Bit 6 Not Used
Bit 7 Not Used
Bit 8 Transmitter to IIU communication error (1=Error)
Bit 9 Transmitter in Startup  (1=StartUp)
Bit 10 Probe or Probe Connection Failure (1=Failure)
Bit 11 Probe or Probe Connection Failure (1=Failure)
Bit 12 Probe or Probe Connection Failure (1=Failure)
Bit 13 Probe or Probe Connection Failure (1=Failure)
Bit 14 Not Used
Bit 15 Not Used
Status 2 - 2 Bytes
Reserved
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OPC Configuration Appendix C

OPC refers to OLE for Process Control protocol and is based on Microsoft’s OLE/
COM technology which is used for data transfer between databases.

When Microcor Tools – Output Interfaces is used on the RCS Intelligent Interface 
Unit (IIU), the Microcor Tools acts as the OPC Server to provide data transfer 
to the DCS, PCS or SCADA system running the OPC Client. While the principle 
of operation is simple, configuration can be complex as OPC is integrated into 
Microsoft security.

Workgroup vs. Domain Setup

Setting up the OPC Server computer (will be referred to as an IIU from this point 
forward) will differ on a workgroup computer network compared to a domain 
computer network. The IIU must be properly configured according to the local 
network to communicate with the client. 

In order for the IIU and Client to properly communicate in a Workgroup environment, 
a common username (with Administrative privileges) and password is required to 
be set on both computers. The IIU and the Client must both be logged on to the 
Workgroup with the same user credentials for successful data transfer.

If the local network is on a domain, the he IIU may be added onto the domain. In 
this case, common usernames and passwords are not required. If the IIU cannot be 
added to the domain, then logon to the Client computer using a local profile instead 
of the domain profile (consult the IT Department for more details and assistance). 
A common username (with Administrative privileges) and password is required for 
successful connection and data transfer.

Most common Server-Client configurations supported are shown below:

OPC Server OPC Client
Server OS User Name Network Client OS User Name Network

XP rcsuser Domain XP rcsuser Domain
XP rcsuser Domain XP user2 Domain
XP rcsuser Domain 2000 rcsuser Domain
XP rcsuser Domain 2000 user2 Domain
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2000 user2 Workgroup 2000 user2 Workgroup
XP rcsuser Workgroup XP rcsuser Workgroup
XP rcsuser Workgroup 2000 rcsuser Workgroup

2000 rcsuser Workgroup XP rcsuser Workgroup
      

XP rcsuser D – LL* XP rcsuser D – LL*
XP rcsuser Workgroup 2000 rcsuser D – LL*
XP rcsuser Workgroup XP rcsuser D – LL*

* PC is configured on the Domain but logged onto a local profile

Determine whether the client computer which will connect to the IIU is set up as a 
part of a domain or a workgroup network. To do this, navigate to Start → Control 
Panel (Classic View) → System and double click the Computer Name tab of the 
intended client computer (shown below):

Note:	 The above image shows that this computer (with the name 
028RCS) is in a Workgroup named WORKGROUP. If the 
system is in a domain, the word “Workgroup” will be replaced 
with “Domain” followed by the domain name.

Configure the IIU on a Domain/Workgroup

Following are the steps taken to configure the IIU on a workgroup or a domain 
network. Administrative privileges on the IIU (username, password) are required in 
order to switch from a domain network configuration to a workgroup. If switching 
from a workgroup to a domain, Administrative privileges to the domain are required 
(consult IT Administrator for assistance). It is recommended that IT Department 
assistance is enlisted when going from a workgroup to a domain network. 

Navigate to Start → Control Panel → System and double click the Computer 
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Name tab. Click on the Change button to advance to the Computer Name 
Changes screen (see image below).

On the Member of area, change from Domain/Workgroup as desired. When OK is 
clicked, it will prompt for a Username and Password of an administrator. If going to 
a workgroup, use a local computer administrator username and password, if going 
to a domain, have the IT Administrator enter the domain Administrator username 
and password.

The RCS Intelligent Interface Unit (IIU) by default is configured is as follows:
	 IIU Administrator Username:	 Administrator
			          Password:	 RCSiiu
 
Automatic Logon username and password:
			       Username: 	 rcsuser
			        Password: 	 rcs

Set up the IIU for a Workgroup Network Environment

The following section will explain the additional setup steps required when 
configuring the IIU in a workgroup network environment. An IIU as supplied is set 
by default as an OPC Server on a Workgroup with the name “WORKGROUP” 
and with automatic logon as Username “rcsuser” and password “rcs”. For RCS 
supplied IIUs or for systems on domains networks, skip to the next section 2. 
Setup Automatic Logon – IIU Default below.
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1. IIU on a Workgroup Network – IIU Default

In order for the IIU and Client to properly communicate it requires a common 
username and password to be set on both computers. It is recommended by RCS 
to use the following username and password with administrative privileges on both 
computers.

User Name: 	 rcsuser 
Password: 	 rcs

Note:	 Administrative privileges are required on the 
computers to add a new user and make the necessary 
changes. It is recommended that the organization’s 
IT Department is consulted for assistance/permission 
prior to changing configuration on the computers.

To create a new user profile, navigate to Start → Control Panel → Administrative 
Tools → Computer Management and expand System Tools. Find Local Users 
and Groups, expand and choose Users. Right-click on the right hand side and 
select New User. 

This will open a New User dialogue box, Enter rcsuser as the User name and rcs 
as the Password and confirm the password.
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Before pressing the Create button;

1.	 Uncheck “User must change password at next logon.” 
2.	 Check “password never expires.” 
3.	 Check “User cannot change password.”

Press Create to create the user and Close the New User dialogue box. The new 
rcsuser profile can now be seen on the Computer Management screen. This user 
can now be added to be a member of the Administrators group.  It is necessary for 
the rcsuser to have administrative privileges on the computer.

To set the configuration;
1.	 Right-click on the rcsuser name and select Properties. 
2.	 Click on the Member Of tab. The rcsuser by default will be in the Users group. 
3.	 Click Add and type in Administrators as the object type and click OK. 
4.	 Click on Users and click Remove (once above steps are completed, rcsuser 

will have administrative privileges on the computer, see image below).

 

2. Setup Automatic Logon – IIU Default

Note:	 Administrative privileges are required to make changes to the 
registry. Follow steps with utmost caution to prevent serious 
damage to the operation of the operation system. 
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Caution:	 Deleting/Editing Registry Keys can cause 
serious damage to the operation of the system, 
only manipulate the described keys below. It 
is recommended that the organization’s IT 
Department is consulted for assistance.

The following configures the username rcsuser and password rcs to automatically 
logon when the IIU is rebooted, substitute the proper username and password 
where applicable. Use the Registry Editor to add the auto logon information by 
following the steps below. 

1.	 Click Start → Run, type regedit and click OK. 

2.	 Locate the following registry key:
•	 HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\WindowsNT\Current-

Version\Winlogon 

•	 Double-click the DefaultUserName entry, 
1.	 Type rcsuser, and then click OK. 

•	 Double-click the DefaultPassword entry, 
1.	 Type rcs under the value data box, and then click OK.
A.	If there is no DefaultPassword value, create the value by following 
the steps below (If no DefaultPassword string is specified, Windows 
XP will automatically change the value of the AutoAdminLogon registry 
key from 1 (true) to 0 (false) to turn off the AutoAdminLogon feature):

a. In Registry Editor, click Edit, click New, and then click String Value. 
b. Type DefaultPassword as the value name of the New Value cre-
ated, and then press ENTER. 
c. Double-click the newly created key, and then type the password 
(rcs) in the Value Data box and click OK. 

•	 Double-click the AutoAdminLogon entry, type 1 in the Value Data box, 
and then click OK.

1.	 If there is no AutoAdminLogon entry, create the entry by performing 
the following steps: 
a.	 In Registry Editor, click Edit, click New, and then click String 

Value. 
b.	 Type AutoAdminLogon as the value name, and then press 

ENTER. 
c.	 Double-click the newly created key, and then type 1 in the 

Value Data box. 

3. Exit the Registry Editor. 

4. Click Start  → Shutdown  → Restart, and then click OK. If the settings were 
changed successfully, the computer will automatically logon to the rcsuser profile.

3. Set Microcor Tools Software to Auto Launch – IIU Default
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When using Microcor Tools for on-line monitoring, it should be setup in the 
Microsoft Windows Startup folder and the Autostart checkbox should be checked.  
This ensures that the program will restart automatically and commence the 
online communication and data collection when the computer is restarted after 
maintenance or power failure.

To add Microcor Tools to the Windows Startup folder, copy the Microcor Tools 
shortcut icon form the desktop and paste it in the C:\Documents and Settings\All 
Users\Start Menu\Programs\Startup directory. 

Setup the Static Internet Protocol (IP) Address

In order for the IIU and the OPC Client computer to communicate, IP Addresses 
may need to be configured. The following recommended procedure is for networks 
that support Dynamic Host Configuration Protocol (DHCP). 

It is recommended that the IIU is set up with Internet Protocol (TCP/IP) Properties 
to “Obtain IP Address automatically” and the Alternate Configuration to be 
configured with the suggested following settings (default configuration of the IIU):

IP Address: 		  192.168.3.1
Subnet Mask:		 255.255.255.0
Default Gateway: 	 192.168.3.254

This configuration enables the IIU to be plugged directly into a network and obtain 
an IP Address from the DHCP Server or use the Alternate Configuration if a DHCP 
Server is not found or unavailable (i.e. if a cross-over cable is used). In order for 
the OPC Client computer to connect when a DHCP Server is unavailable, the 
Alternate Configuration on the client computer should be setup with an incremented 
IP Address such as 192.168.3.5 (IP Address range must be within 192.168.3.2 to 
192.168.3.253, however, if the IIU contains more than one network interface card, 
successive IP Addresses may be allocated, hence it is recommended that the 
client IP Addressing begins at 192.168.3.5). Consult the IT Department for more 
details.

The typical navigational path and procedure to make the TCP/IP changes is as 
follows;

1.	 Start → Control Panel → Network Connections → Local Area Connection. 
2.	 Right-click and select Properties.
3.	 Scroll, find and select the Internet Protocol (TCP/IP) under the General tab.
4.	 Click the Properties command button. See image below:
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5.	 Set the configuration as follows under the General and Alternate 
Configuration tabs:

     

Note:	 If Static IP Addresses are used exclusively in the Domain or 
Workgroup, consult the IT Department for available Static IP 
Addresses, Subnet Mask, Default Gateway and assistance. 
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Windows Firewall Setup

Navigate to Start → Control Panel → Windows Firewall and select Off (not 
recommended) and click OK.

The Windows Firewall is designed to stop any incoming unsolicited communication 
across the network. In order to achieve successful communication with ease, the 
Windows Firewall of the RCS IIU is set to Off as the default configuration. It may 
be appropriate to permanently turn off the firewall if the machine is sufficiently 
protected behind a corporate firewall, however, this should be decided by the IT 
personnel of the ultimate destination where the IIU will reside.

Note:	 Once the setup procedure is completed and communication 
is verified, enable the firewall following the same process 
as above and selecting ON (recommended). When 
enabling, certain Exceptions will need to be configured on 
the Windows Firewall. Refer to Appendix 4 for more details.

Note:	 If a cross-over cable is used to connect to the IIU, then the 
Windows Firewall may be required to be turned off prior 
to establishing the connection. Re-enable the firewall after 
disconnecting from the IIU.
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Setup Windows Folder Properties: Disable “Use Simple Sharing” – IIU Default

1.	 Double click My Computer from the desktop or right-click Start and select Explorer. 
2.	 Click Tools → Folder Options and select View tab (shown below). 
3.	 Uncheck the “Use simple file sharing (Recommended).”
4.	 Click Apply followed by OK.

Install Microcor Tools Software and OPC Server Application – IIU Default

Install the Microcor Tools Software from the installation CD. It is important to retain 
all default options when installing. Once the installation is complete, follow the 
steps below to register the OPC Server.

1.	 Click Start → Run, type cmd and click OK. 
2.	 Type cd C:\  
3.	 Type cd Program Files\MicrocorTools
4.	 Type MTXOPCServer.exe – regserver
5.	 If error messages appear, the registration is unsuccessful; make sure all steps 

are performed as explained above and that the user has sufficient privileges on 
the computer. Otherwise Type cd C:\  

6.	 Type cd Windows\System32
7.	 Type OPCEnum/regserver
8.	 If error messages appear, the registration is unsuccessful; make sure all steps 

are performed as explained above and that the user has sufficient privileges 
on the computer. Otherwise Type Exit to leave the Command Prompt window 
(see image below). 
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9.	 Install OPC Client Test Utility (Follow all instructions carefully when installing 
this application. Failure to follow instructions may result in serious damage to 
the operating system. Consult RCS for more information).

Setting up DCOM Properties (Workgroup Networks Only) – IIU Default

DCOM properties must be configured to assure the communication between the 
OPC Server and Client when using workgroup networks. Skip to the next section 
Launching OPC Server if using a domain network. 

To setup the DCOM properties;

1.	 Navigate to Start → Control Panel → Administrative Tools → Component Services.
2.	 Expand the Console Root by clicking on it. 
3.	 Click on the Component Services → Computers → My Computer → DCOM Config 

(see image below). 
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4.	 Find the MTX OPC Server entry.
5.	 Right-click and choose Properties (shown above). 
6.	 Change the Authentication Level to Default on the General tab.

7.	 Select only the “Run application on this computer” on the Location tab and 
click Apply as shown below.

8.	 Change the Launch and Activation Permissions, Access Permissions and 
Configuration Permission to Customize in the Security tab and click Apply.
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9.	 Click the Edit button under the Launch and Activation Permissions and 
ensure that rcsuser (or the appropriate username) is added. 

10.	Verify that the permissions on all the Groups or Users are setup as shown 
below (note that the Remote Launch is disabled on all Groups or Users). Click 
OK.

11.	Click the Edit button under the Access Permissions and ensure that rcsuser 
(or the appropriate username) is added and all Groups and Users have full 
permissions allowed as shown below. Click OK.
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12.	Click the Edit button under the Configuration Permissions and ensure that 
rcsuser (or the appropriate username) is added and all Groups and Users 
have full permissions allowed as shown below. Click OK.

13.	Click Apply on the Security tab before moving on to the Endpoints tab (no 
changes made on the Endpoints tab, shown below).
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14.	Select the “The Interactive User” on the Identity tab and click Apply.

The OPC Server is now ready to be launched for the Workstation Network setup.
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Setting up COM Security Properties – IIU Default

It is necessary to Edit Limits of the My Computer Properties of DCOM COM 
Security to allow Everyone full privileges. See below for step-by-step directions:

Note:	 Since Everyone includes all authenticated users, it is 
often desirable to add these permissions to a smaller 
subset of users once all communications are verified. One 
suggested method by OPC Foundation to accomplish 
this is to use a group name such as “RCSOPC Users” 
and add all user accounts to this group that will execute 
any OPC Server or Client. Then substitute “RCSOPC 
Users” everywhere that Everyone appears in these 
configuration dialogs. RCS uses Everyone as a starting 
point since it is the most unrestricted and simple method 
to establish and verify connection. Refer to OPC 
Foundation website for best practices.

1.	 Navigate to Start → Control Panel → Administrative Tools → Component Services.
2.	 Expand the Console Root by clicking on it. 
3.	 Click on the Component Services → Computers and right-click the My Computer 

icon and select Properties to enter the My Computer Properties (see image below).

4.	 On the My Computer Properties, click the Com Security tab and click the 
Edit Limits button under the Access Permissions area. Image shown below:
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5.	 Make sure Everyone is added under the Group or User Names and both 
Local Access and Remote Access are set to Allow for both Everyone and 
ANONYMOUS LOGON.

6.	 Click on the Default Properties tab.
a.	 Check the “Enable Distributed COM on this computer.”
b.	 Uncheck “Enable COM Internet Services on this computer.”
c.	 Select Connect on the Default Authentication Level.
d.	 Select Identity on the Default Impersonation Level.
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Launching the Microcor Tools OPC Server

The Microcor Tools Software is configured to automatically launch when the IIU is 
started. If it is necessary to manually run the software, perform the following steps:

1.	 Run the Microcor Tools Software application from Start → All Programs → 
RCS → Microcor Tools.

2.	 Create a New Site or choose an Existing Site to enable the Online Communication Area.
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3.	 Click on the Interfaces Configuration button to open the Interfaces screen. 
On the OPC area, select Enabled and Save Configuration and Return.

4.	 When the Enabled selection is made, OPC icon will appear on the Windows 
Status bar as shown below:

5.	 Double-click on the OPC icon show above to open the OPC Server status 
screen. Users may monitor the connections from this screen. The values for 
statistics will dynamically change as clients log on and off of the OPC Server. 
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Note:	 It is important to note that the OPC Server shows values 
(Unit, ML, TC, CR-LR, CR24 and Stat) on the status bar. 
These values will only be present if the data are transferring 
correctly; otherwise the values will be blank. This means 
that either the Online Communication - Interfaces area 
is not properly configured or that the OPC Server was 
invoked by the OPC Client Test Utility installed on the 
computer and that Microcor Tools -Output Interfaces is 
not running (OPC Client Test Utility is preinstalled only on 
computers provided by RCS), see the Troubleshooting 
section below for more details.

6.	 The OPC Server is now set to transfer data. Make sure to Start the Online 
Communication and Data Collection (shown below); the OPC Client 
computer will now receive the data being transferred (make sure to use the 
same credentials on the OPC Client computer as used on the OPC Server 
computer for Workgroup networks).

Using the Preinstalled OPC Client Test Utility on RCS IIU to Test the OPC Server

If the IIU is configured and shipped by RCS, an OPC Client Test Utility application 
will also be installed just to verify the functionality of the OPC Server. This OPC 
Client Test Utility can be run by following the steps below:

1.	 Run the OPC Client Test Utility application from Start → All Programs → 
VB6Client

2.	 Normally, in order for a client to see a server, the OPC Server PC name or the 
IP address must be typed in; however in this case since both the server and the 
client reside on the same machine, click on the drop-down arrow of the OPC 
Servers: to automatically browse and find the OPC Server. When the Server is 
found, click on it to make the selection and then click on the Connect button.
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3.	 Click on the Add Group button of the OPC Groups area. This will browse, 
find and enter the group to the text box. 

4.	 Click on the Browse button of the Namespace area. This will browse, find 
and enter the Namespace group on the text area. Expand the selection by 
clicking on the plus (+) sign to show the detailed listing. Click the plus (+) sign 
as required to see the individual selections. Right-click on each selection and 
left-click to select and view the data.
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Troubleshooting

1.	 OPC Server is started and the OPC Client Test Utility on the same computer 
can connect, but the Remote OPC Client computer cannot connect.

•	 Disable the Windows Firewall temporarily on both computers until the 
connection is established. See Appendix 4 for details on setting the 
Windows Firewall.

•	 Ensure the IP Addresses are correct and the connection cables are secure 
on the IIU and the OPC Client computer.

2.	 OPC Server is started and the Client is connected but Client shows 0 for 
transferred values.

•	 Ensure that the Start buttons are activated on the Online Communication 
and Data Collection as shown below on the on the Site/Communications 
screen.
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•	 Check the OPC Server status by clicking on the OPC icon on the computer 
status bar. If the OPC Server does not show values (Unit, ML, TC, CR-LR, 
CR24 and Stat) on the application status bar then check the Interfaces 
Configuration of the Online Communication area to ensure the OPC 
interface has been Enabled (see the following images).

If the Status bar shows no activity as shown above then the OPC Server is not 
transferring data. Enable the OPC Interface and Save Configuration as shown below:



96 OPC CONFIGURATION

3.	 OPC Client computer does not receive data after the IIU reboot.

•	 Ensure the OPC Server is started and running.

•	 Ensure the Autostart is checked on the Online Communication area, 
shown below:

•	 If the Autostart was selected, click Stop to enable the Interfaces 
Configuration button. Click the Interfaces Configuration button and 
make sure the Enabled is selected on the OPC area; Save Configuration 
and Return and try again.

4.	 OPC Server is started and the RCS provided OPC Client Test Utility on the 
same computer and Remote computer can connect, but other OPC Client(s) 
cannot connect.

•	 Ensure that the OPCEnum is registered.

•	 Verify that the COM Security is configured to allow Everyone or the User 
full privileges.
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Windows Firewall Configuration Appendix D

The Windows Firewall is designed to stop any incoming unsolicited communication 
across the network. This firewall is Exception based; therefore, rules can be put 
in place to handle unsolicited requests.  Administrator can specify applications and 
ports that are exceptions to the rule. Following changes are required to make any 
OPC client/server application work via DCOM.

Configuring the Windows Firewall Exceptions and Ports

1.	 Navigate to Start →  Control Panel →  Windows Firewall (shown below). 

2.	 Set the firewall to On position. This is the recommended setting by Microsoft, 
OPC and RCS to give the computer the highest possible protection. Turning off 
the firewall is recommended only when troubleshooting an issue.

3.	 Select the Exceptions tab (shown below). 
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4.	 Select (check) the Microsoft Management Console. If this is unavailable as 
a selection, perform the following:
a.	Click Add Program.
b.	Click Browse button.
c.	 Navigate to C:\WINDOWS\SYSTEM32\MMC.EXE and click Open.
d.	Click OK to add MMC to the Exceptions.

5.	 Add any OPC Clients and Servers by scrolling through the selection. 

6.	 Click on the Add Program button and add Microcor Tools, MTXOPCServer.
exe and OPCEnum.exe to the list. If these are not on the list, they can be 
found by using the Browse button and navigating to:
a.	C:\Program Files\MicrocorTools\ MCorSetup.exe for Microcor Tools 
b.	C:\Program Files\MicrocorTools\MTXOPCServer.exe for 
MTXOPCServer
c.	C:\Windows\System32 for OPCEnum



MICROCOR® TOOLS  SOFTWARE VERSION 4.4.5 99

7.	 Click the Add Port button under the Exceptions tab. Fill in the information as 
follows on the Add a Port dialogue box;

Name: 		  DCOM
Port number: 	 135
Protocol:		  TCP
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